# Table of Contents

Part I: Designer Projects

## 1. INTRODUCTION/ABOUT THIS GUIDE ................................................................. 9
   - About This Guide .................................................................................. 9
   - Designer vs. Design360 ................................................................. 9
   - For Users of Designer Suite 2005 ....................................................... 9
   - Installing and Administering Smartware Studio .................................. 9
   - To Learn More about Smartware Studio ........................................... 10
   - To Contact Us ............................................................................... 10

## 2. CREATING A NEW DESIGNER PROJECT .................................................... 11
   - Creating a New Designer Project ....................................................... 11
   - The Project Tree and Folders ......................................................... 12
       - Creating a Template for New Projects ........................................ 13
   - Project Properties .......................................................................... 14

## 3. WORKING WITH VISIO FILES AND SYSTEMS ........................................... 15
   - Creating a New Drawing File ............................................................ 15
   - Opening a Drawing File in Visio ..................................................... 15
       - The DS 2005 Tools Menu ............................................................ 15
       - Visio Page Size ....................................................................... 16
   - File Properties for Single-File Library Systems .............................. 18
   - The Single-File Standard System Library ....................................... 19
       - Inserting a Standard System from the Single-File Library ............ 19
       - Copying a System into the Standard Library ............................... 20

## 4. WORKING WITH STENCILS AND SMART SHAPES .................................... 21
   - Opening a Designer Stencil .............................................................. 21
   - Adding a Shape to the Drawing ...................................................... 22
   - The Anatomy of a Smart Shape ...................................................... 22
   - Shape Properties .......................................................................... 23
       - Accessories ........................................................................... 25
   - Creating Custom Shapes and Stencils ............................................ 25
       - Storing Your Custom Stencils ................................................... 26
       - Sharing Custom Stencils ......................................................... 26

## 5. SYSTEM NAMES AND THE SYSTEM LIST .................................................. 27
   - Specifying the System Name .......................................................... 27
       - The System List ..................................................................... 27
   - Finding and Replacing System Names ............................................ 28
   - Sub-Systems ............................................................................... 28
   - Typical Of Values .......................................................................... 28
       - Setting the Typical Of Value for a System .............................. 29
       - Smart Charts ......................................................................... 29
6. **VALVE, DAMPER AND AIR FLOW SCHEDULES** .............................................. 31
   Valve Schedules ........................................................................................................ 31
      Creating a Valve Schedule....................................................................................... 31
      Opening the Valve Schedule .................................................................................. 32
      The Valve Schedule Options Dialog ...................................................................... 32
      The Valve Schedule Workbook .............................................................................. 32
      The Valve Sizer and Selector .................................................................................. 33
      Calculating a Cv Range ......................................................................................... 34
      The Valve Schedule Worksheet .............................................................................. 35
         Adding Valves to the Schedule ............................................................................ 35
         Removing Valves from the Schedule .................................................................... 36
      The Valve Schedule Columns ............................................................................... 36
      Piping Detail ............................................................................................................ 37
   Air Flow and Damper Schedules .............................................................................. 38
      Including Schedule Parts in the Bill of Materials .................................................. 38
      Customizing the Schedules .................................................................................... 39
         To Expose the DsScheduleProperties Worksheet ................................................ 39

7. **CUSTOMIZING DESIGNER** .................................................................................. 41
   Storing and Distributing Customized Files ................................................................. 41
      Local Files .............................................................................................................. 41
      Server Files ............................................................................................................ 41
   Custom Template Documents ................................................................................... 42
      Custom Template Locations .................................................................................... 43
      Selecting a Custom Template .................................................................................. 44
      Distributing and Auto-Selecting Custom Templates for an Organization ............. 44
      Customizing the Blank Drawing File ...................................................................... 45
      Customizing Valve, Damper and Air Flow Schedules ............................................ 46
   Custom Visio Stencils ............................................................................................... 46
      Visio Stencil Files Locations ................................................................................... 46
      Creating and Using Custom Stencils and Shapes .................................................... 47
      Distributing Custom Stencils .................................................................................. 47
      Customizing the Title Block Shape ....................................................................... 47
   Custom Reports ......................................................................................................... 49
   Custom Parts ............................................................................................................. 50

**Part II: Designer Drawings**

8. **PAGE ADD INS** .................................................................................................... 51
   Title Blocks ................................................................................................................ 51
      The Title Block Information .................................................................................... 52
      Updating Title Blocks in Multiple Drawings ......................................................... 53
   Bill of Material Shape ............................................................................................... 53
   Typical Of Value ....................................................................................................... 54
   Revision Bubbles ....................................................................................................... 55

9. **THE SMART SHAPES** ......................................................................................... 57
   Generic Shapes .......................................................................................................... 57
      Duct Shapes (Duct.vss) ......................................................................................... 57
      Water Shapes (Water.vss) ...................................................................................... 58
      Computer Devices (Computer Devices.vss) .......................................................... 58
      Other Generic Shapes ............................................................................................ 59
10. CONTROLLERS AND DEVICES ................................................................................. 65

Device Shapes ........................................................................................................... 65

   Device Shape Properties ....................................................................................... 65

I/O Points ......................................................................................................................... 66

   I/O Point Shape ......................................................................................................... 67

Sensors and Transmitter Shapes .................................................................................. 67

The Controller I/O Tab Page .......................................................................................... 70

Auto Insert ...................................................................................................................... 72

Error Checking .................................................................................................................. 72

   Error Colors ............................................................................................................... 73

Clearing the Error Colors ............................................................................................... 73

Invalid Point Types .......................................................................................................... 73

11. PANEL DEVICES AND AUTOMATION OVERVIEW ................................................ 75

Scaling in Panel Layouts ................................................................................................. 75

Enclosure Shapes ............................................................................................................. 75

Panel Device Shapes ....................................................................................................... 76

   Panel I/O Points (Panel I/O Points.vss) .................................................................... 78

Automation Overview ..................................................................................................... 78

   Power and Bus Connectors ....................................................................................... 79

Terminal Blocks ............................................................................................................. 79

12. TERMINAL BLOCKS ................................................................................................. 81

Creating a New Terminal Block Shape ........................................................................... 81

Adding Terminal Parts ..................................................................................................... 82

   The Line Type .............................................................................................................. 82

   The Show on Bill of Materials Check Box .................................................................. 83

   The Part Number ......................................................................................................... 83

   The Wire Tag ............................................................................................................... 84

   Brackets ....................................................................................................................... 84

Editing a Terminal Block ................................................................................................. 85

Fill Down .......................................................................................................................... 86

   Fill Down Using ......................................................................................................... 86

   Fill Down Until ............................................................................................................ 87

   Fill Line Type/Show on BOM/Part Number/Wire Tag Type/Bracket Type .................. 87

   Fill Part Label/Wire Tag Label/Bracket Label ............................................................. 87

Panel Version .................................................................................................................. 87

Adding Custom Terminal Parts ....................................................................................... 88
13. **WIRE TAGS** .......................................................................................................................... 91

   What is the Wire Tag? .................................................................................................................. 91
   The Wire Tag Shape .................................................................................................................. 91
   Wire Tag Reports .......................................................................................................................... 93
   - System Tag Report (Wire Tags - Grouped by System.xls) ......................................................... 93
   - Controller Tag Report (Wire Tags - Grouped by Controller.xls) ............................................... 94
   - Total Tag Reports (Wire Tags - Total [with System].xls) .......................................................... 94
   - Adding Wire Tag Parts to the Parts Database ........................................................................... 94

14. **SMART CHARTS** .................................................................................................................. 95

   What Is A Smart Chart? .............................................................................................................. 95
   Creating a Smart Chart .............................................................................................................. 95
   - The Anatomy of a Smart Chart .............................................................................................. 97
   - Selecting the Fields in a Smart Chart .................................................................................... 97
   - Selecting the Fields to Display in a Smart Chart ................................................................. 99
   Editing the Smart Chart Data .................................................................................................... 99
   Generating a Smart Chart Report .............................................................................................. 100
   Smart Chart Templates .......................................................................................................... 101
   - Creating a Smart Chart Template ......................................................................................... 101
   - Inserting Smart Chart Fields Using the Template Editor ..................................................... 102
   - Running a Custom Report ..................................................................................................... 105
   - Assigning a Template to a Smart Chart ................................................................................ 105
   - The User Dictionary .............................................................................................................. 107
   Modifying the Master Device and System .............................................................................. 108
   - Changing the Number of Rows in the Smart Chart ............................................................ 108

15. **SMART CLONES** ................................................................................................................ 111

   Creating a Smart Clone ............................................................................................................. 111
   - Drawing Smart Clone Shapes ............................................................................................... 113
   - Storing Smart Clones in Stencils ......................................................................................... 113
   Smart Clone Part Properties .................................................................................................... 113
   - Editing the Smart Clone Properties ...................................................................................... 114
   - Part Number Filters .............................................................................................................. 115
   Smart Clone Terminals ........................................................................................................... 116
   - Configuring the Terminals Tab ............................................................................................. 116
   - Showing Terminal Values in the Shape ................................................................................. 117
   Using the Smart Clone Designer .............................................................................................. 118
   Label and Terminal Components ............................................................................................ 118
   - Component Properties ......................................................................................................... 119
   - Component Text Values ......................................................................................................... 120
   - Selectively Showing and Hiding a Component .................................................................... 121
   - Flipping a Terminal Component ........................................................................................... 122
   - Changing the Component Font ............................................................................................. 122

**Part III: Designer Tools**

16. **THE PAGE WIZARD** ......................................................................................................... 123

   Running the Page Wizard ......................................................................................................... 123
   Renumbering the Pages ............................................................................................................. 124
   Updating Project Information Fields .......................................................................................... 125
   Updating the Drawing Files ..................................................................................................... 125
17.  **THE PRINT MANAGER** ................................................................. 127
    Using the Print Manager ........................................................................ 127
    Printing the Pages .............................................................................. 128
      The Print Order ............................................................................. 128
      Printing to a PDF File .................................................................... 129

18.  **REVISION NOTES** ................................................................. 131
    The Revision Notes Section of the Title Block .................................... 131
    The Revision Notes Tool ................................................................... 131
    Removing Revision Bubbles .................................................................. 133

19.  **TABLE OF CONTENTS** ......................................................... 135
    Creating a Table of Contents ............................................................... 135
    Opening and Editing a Table of Contents ............................................ 135
    The Table of Contents Drawing File ................................................... 136
    The Table of Contents Wizard Form .................................................... 137
      Adding Additional Items to the Table of Contents .......................... 138
    Custom Format Strings ...................................................................... 139
    Changing the Font Used in the Table of Contents .............................. 140
    Modifying the Table of Contents Template ........................................ 140

20.  **VALVE LEGENDS** ................................................................. 143
    Creating a Valve Legend ..................................................................... 143
    Customizing the Valve Legend Template ............................................ 145

21.  **REPORTS** .................................................................................. 147
    Generating Reports ............................................................................. 147
    Types of Reports .............................................................................. 148
      Material Reports ........................................................................... 149
      TAC iPortal Reports ...................................................................... 149
      Parts Reports .............................................................................. 151
      Controller and Commissioning Reports .......................................... 153
      Software Reports .......................................................................... 157
      Wire Tag Reports .......................................................................... 157
    Creating Custom Reports ................................................................... 157
      Distributing Custom Reports ......................................................... 158
    Report Templates ............................................................................. 158
      Field Codes .................................................................................. 159
      Report Sections ........................................................................... 159
      The Control Column ..................................................................... 160
      Grouping ..................................................................................... 160
      Adding Filters .............................................................................. 160
      Using Formulas ........................................................................... 161
      Aggregate Formulas ...................................................................... 161
      Grand Totals ............................................................................... 162
      <X> Data Section ........................................................................ 162

22.  **GATHERING PDF FILES** .................................................... 165
    The Gather PDF File Tool ................................................................... 165
    Gathering and Printing the PDF Files ................................................ 166
    The PDF Report ............................................................................ 166
23. **INTEGRATING WITH WORKPLACE TECH** ......................................................... 169

- Overview of the WorkPlace Tech Integration .......................................................... 169
- Selecting the WorkPlace Tech Project ..................................................................... 170
- Selecting the Devices to Convert to Applications .................................................... 171
- Selecting the WorkPlace Tech Document Properties ............................................. 172
- Creating the WorkPlace Tech Applications ............................................................. 173
- Typical Of Systems and Smart Charts .................................................................... 176
1. **Introduction / About This Guide**

This Guide will describe the features and functionality of the Smartware Studio Designer Module.

**About This Guide**

This guide is divided into three major parts:

- Part I: Designer Projects
- Part II: Designer Drawing Files
- Part III: Designer Tools

Please refer to the table of contents for a complete list of chapters and topics.

**Designer vs. Design360**

The Designer Module is also known as Design360. There is no difference in functionality between the two editions. The only changes are cosmetic, such as the icon and the phrase Design360 replacing Designer.

**For Users of Designer Suite 2005**

If you already use the previous stand-alone version of Designer Suite 2005, you will want to read the Upgrading from Designer Suite 2005 document available from the Help menu.

**Installing and Administering Smartware Studio**

For complete details on how to install, setup and configure Smartware Studio refer to the separate Smartware Studio Setup and Administration Guide. Specific Chapters of note include:

- Configuring a Smartware Studio Workstation (PDF Files and Visio Settings)
- The Parts Database Manager
To Learn More about Smartware Studio
Many of the topics covered in this Guide are better illustrated through visual examples. To that end, our video training sessions are available for viewing and downloading from our web site. We encourage you to use these videos as part of your training.

This guide also assumes a certain amount of familiarity with the basic concepts of Smartware Studio. For more information about using Smartware Studio projects, refer to the separate Smartware Studio User’s Guide.

To Contact Us
Our technical support team is available weekdays from 8 am to 5 pm Eastern time at (716) 213-2222. You may also visit our web site at http://www.smartwaretech.com or e-mail us at techsupport@smartwaretech.com.
2. Creating a New Designer Project

A Designer Project is a set of folders and files related to a set of engineering drawings typically referred to as a *submittal*. You can embed a Designer project in another Smartware Studio project (such as Customer Site or Job), or you can create it as a separate project.

Refer to the *Smartware Studio User’s Guide* for complete details on creating and manipulating projects on your server.

Creating a New Designer Project

To create a new Designer Project:

- Select FILE→NEW PROJECT to bring up the Open Project dialog.
- Click the NEW PROJECT… button.
- In the PROJECT TYPE list, select *Designer* (or *Design360*):
  
  ![New Project Dialog]

  - Specify a PROJECT NAME and (optionally) a CUSTOMER NAME.
  - Click the CREATE button.
The Project Tree and Folders

When a new default project is created, there will be three nodes in the Project View:

- The root Designer node has tabs for Project Properties, Designer Tools and the Reports.
- The Systems folder is used to store Designer Visio Drawings
- The Schedules folder is used to store Valve, Damper and Air Flow Schedules.

You can add to this tree structure in many ways, adding additional folders for your own information or additional Systems and Schedule folders. Refer to the Smartware Studio User’s Guide for more details.

The Systems and Schedule folders are special cases of the standard folder node:

- They have different icons
- Designer will automatically scan the files in these folders for drawings and schedules (and will not scan files outside these folders)
You can change a plain folder into a Systems or Schedules folder by selecting the folder and going to its **Properties** tab:

- The **DS Folder Scan Type** indicates if it's a scannable folder.

### Creating a Template for New Projects

If you are a Smartware Studio administrator, you can create a pre-defined folder structure to use for new projects (instead of the default):

- Create a Designer project and structure the Project Tree the way you want all new projects to look.
- Upload the project to the Server.
- In the Open Project list, right-click on the project and select **ADMIN ➔ MAKE PROJECT A NEW PROJECT TEMPLATE**.

The next time you create a New Project, you will be prompted for a **PROJECT TO DUPLICATE** showing a list of this project (and any others you specify as Templates). If you choose one, the template project will be duplicated to create the new project.
Creating a New Designer Project

**Project Properties**
When you create a new project, you will want to specify the *Project Properties*:

- Select the root Designer node, then the PROPERTIES tab and the PROJECT sub-tab.
- The values specified in the Project Properties can be carried over to the Title Block, Table of Contents, Valve Schedules and other Reports.
3. Working with Visio Files and Systems

The details of a Designer project are contained in the drawing files. These Visio files are created using Designer’s stencils of standard parts, enhanced with part-specific properties that enable Designer to create detailed reports and utilize other project tools.

A drawing file can represent one or more systems. Later chapters will discuss how each part can belong to a system, but very often the drawing file itself represents a system, such as an Air Handling Unit or a VAV box.

Creating a New Drawing File

- To create a new, blank drawing, right click on the appropriate system folder (or in the empty area of the Files tab of a system folder) and select NEW → DESIGNER DRAWING.
- The blank drawing is created as a copy of the Blank Drawing template, which can be customized (refer to the chapter on Customizing Designer).
- To insert a copy of a file from the Standard System Library, right click on the appropriate folder and select INSERT DRAWING FROM SINGLE-FILE LIBRARY.

Opening a Drawing File in Visio

To load a drawing file into Visio, simply double-click the file name in the Files Tab, or right-click the file name and select OPEN.

The DS 2005 Tools Menu

When a drawing file is opened in Visio, Designer adds a custom menu called DESIGN TOOLS to the end of the Visio menu bar (after the Visio HELP menu in Visio 2007 and earlier, on the ADD-INS tab of the ribbon in Visio 2010 and later).
The DESIGN TOOLS menu contains the following sub-menus and commands:

**SMARTCLONE** Provides the ability to create your own Smart Shapes and link them to custom parts that you add to the Parts Database. Refer to the later chapter on *Smart Clones*.

**ERROR CHECKING** Scans the parts in the drawing and runs a set of error checks, such as finding duplicate Bill of Material Tags and Invalid Point Types. Refer to the section on Error Checking in the later chapter on *Working With Smart Shapes*.

**SYSTEM NAMES** Provides utilities for work with the System Name field of most Smart Shapes. Refer to the section on System Names in the later chapter on *Working With Smart Shapes*.

**Visio Page Size**
The page size when viewed and printed is controlled by Visio. To ensure that your drawings are printed correctly, you should select the Page Setup dialog in Visio:

- In Visio 2007 and earlier, select **FILE** → **PAGE SETUP** from the menus.
- In Visio 2010 and later, select the **DESIGN** tab in the ribbon, and click the small arrow in the lower-right corner of the **Page Setup** region:
You will want to check the following in the Page Setup:

- On the **PRINT SETUP** tab, check the **PRINTER PAPER size** and the **PORTRAIT/LANDSCAPE** settings:

![Page Setup](image)

- On the **PAGE SIZE** tab, it is usually best to select **SAME AS PRINTER PAPER SIZE**.

![Page Setup](image)
File Properties for Single-File Library Systems

When a drawing file represents a system, you can specify the details of the system for use by the Single-File Library for storing and searching for systems.

Note: There is also a mechanism for storing multiple files of different types together in a library. The Multi-File Library is discussed in the Smartware Studio User’s Guide.

To specify and edit the Single-File System Properties:

- To edit the file properties, right-click on the file and select PROPERTIES.
- In the lower file properties pane, select the Designer tab and the System Properties sub-tab.

You can select the category for the system, and for each category specify a different set of property values.

The system properties are stored in the Visio file itself as Extended Properties. This means that they will remain associated with the file even if you move it between projects, copy it to and from Windows, or transfer it electronically by any means, including e-mail.
The Single-File Standard System Library

Once you’ve designed a system as a drawing file, you may want to make it a standard for your organization. Designer allows you to store these standard systems in the System Library.

- The System Library is stored in a folder with your local files, and systems can be easily shared between users in an organization. Select the TOOLS → OPTIONS menu and refer to the System Library tab for more details.

Inserting a Standard System from the Single-File Library

You can insert a standard system from the library by right-clicking on a Systems folder in the Project View (or in the empty area of the Files tab) and selecting INSERT DRAWING FROM SINGLE-FILE LIBRARY.

You will have the opportunity to browse the system list by Category and sub-properties.

If you select a system in the list, its properties will be displayed in the bottom right pane. You can edit the values of this system in the library by clicking on the EDIT PROPERTIES… button.

When you locate the system you want, click INSERT SYSTEM to have a copy added to your project.


**Copying a System into the Standard Library**

You can copy a system file from your project into the library by right-clicking on it and selecting **SEND TO SINGLE-FILE LIBRARY**. You can specify its system properties in your project before sending it to the library (right-click on it and select **PROPERTIES**) or after you’ve put the copy into the library.
4. Working with Stencils and Smart Shapes

The Designer stencils contain hundreds of shapes that you can use on your drawings. These fall into a few different categories:

- **Simple Shapes**, like those included with Visio, which do nothing but appear on the page.
- **Smart Shapes** that correspond to a physical part, which allow you to set a wide range of properties such as Bill of Material Tag and Quantity for use in reports.
- **Advanced Smart Shapes** that correspond to devices, such as controllers, which add the ability to set I/O point information for use in commissioning reports.
- **Page Add In Shapes**, such as Title Block and Bill of Material listing, which interact with Designer and enhance the drawing.

Later chapters will review the various shapes in the stencils in turn. This chapter will discuss features and actions that are common to many of the shapes.

**Opening a Designer Stencil**

Before you can add a shape, you must open the corresponding Designer stencil in Visio.

To open a stencil in Visio 2003 or Visio 2007:

- Select **FILE ➔ SHAPES ➔ DESIGNER** (or **DESIGN360**). You should see a list of the folders containing the Designer stencils; or
- Click on the **SHAPES** icon in the toolbar:
Working with Stencils and Smart Shapes

Top open a stencil in Visio 2010:

- In the left hand side of Visio, ensure that the *Shapes* pane is expanded
- Click the *More Shapes* region, then select the *Designer* menu

![Visio Interface](image)

**Adding a Shape to the Drawing**

To add a shape to the drawing, simply select it in the stencil and drag it onto the drawing page.

**The Anatomy of a Smart Shape**

Each Smart Shape will appear different, but they have a number of features in common:

- There are pieces of text representing the *Part Number, Description, Bill of Material, Range* and *Note*. You can turn their visibility on or off from the Shape Properties dialog. You can also move them around by dragging their yellow control handle.
• Some shapes have terminals, with text labels that may vary from part to part, and wire leads that can be extended by dragging their yellow control handles.

• If you right-click on the shape, the first menu item will often be SHAPE PROPERTIES (or something more specific, such as ACTUATOR PROPERTIES). You can also bring up the Shape Properties by double-clicking the shape.

**Shape Properties**

When you double-click a Smart Shape (or select the SHAPE PROPERTIES menu item), you will see the Shape Properties dialog. This dialog varies from shape to shape, but most have the same basic fields in common.

![Electric Actuator Part Properties](image)

The fields are:

- **Bill of Material Tag**  A 16 character tag for use on material reports.
- **Show on BOM**  Determines whether the part will appear on the material reports.
- **Part Number**  This is generally selected from a list, either by clicking the PART LIST... button (in newer shapes) or dropping down the list box (in older shapes).
- **Quantity**  The quantity of the part for material reports.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Typical</td>
<td>When use in systems that are Typical Of multiple instances, indicates that this part should not have its quantity multiplied by the Typical Of value. See the later chapter on <em>System Names and the System List</em> for more information.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the part, automatically loaded from the database when the Part Number is selected.</td>
</tr>
<tr>
<td>System</td>
<td>The name of the System for the part. See the later chapter on <em>System Names and the System List</em> for more information.</td>
</tr>
<tr>
<td>Range</td>
<td>Used for certain parts to display the range (e.g. Signal Range).</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor name for the part, automatically loaded from the database when the Part Number is selected.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>The manufacturer name for the part, automatically loaded from the database when the Part Number is selected.</td>
</tr>
<tr>
<td>Note</td>
<td>An optional note to show on the shape.</td>
</tr>
<tr>
<td>PDF Cut Sheet</td>
<td>The name of the PDF Product Information Sheet, automatically loaded from the database when the Part Number is selected. In newer shapes you can click the VIEW… button to view the file. In older shapes you can double-click on the file name.</td>
</tr>
<tr>
<td>Installing Trade</td>
<td>An indication of where the part will be installed (Mechanical, Electrical, Panel, etc.). You can sort and sub-sort Bill of Material reports on this value. To add new values to this list, refer to the earlier chapter on <em>Customizing Designer Suite 2005</em>.</td>
</tr>
<tr>
<td>Show On Shape</td>
<td>Indicates which of the floating text values should be shown on the shape.</td>
</tr>
</tbody>
</table>
Accessories

Many shapes also have a tab that allow you to specify Accessories. These are additional parts to add to the Bill of Material.

Accessories are automatically assigned a Bill of Material tag based on the tag of the main part (e.g. DM1_1, DM1_2, etc.).

Creating Custom Shapes and Stencils

You can create your own shapes, either from scratch (as Smart Clones) or by modifying an existing shape from a Designer stencil. If you do, there are several critical rules you must follow:

- Never store your shapes in the Designer stencil files. These files will be overwritten every time Designer is updated.
- Never copy one of our stencil files to use for storing your shapes. Our stencils contain underlying code and names that may conflict with itself if duplicated. Moreover, if this code changes significantly, those custom versions will be out of date and cause further conflicts.
- Always store your shapes in blank stencils created from the Visio menu:
  - FILE ➔ STENCILS ➔ NEW STENCIL (Visio 2002);
  - FILE ➔ SHAPES ➔ NEW STENCIL (Visio 2003 and 2007);
  - (Shapes Panel) MORE SHAPES ➔ NEW STENCIL (Visio 2010)
Never name your stencil files with the same name as one of the Designer standard stencils.

**Storing Your Custom Stencils**

You should store your custom stencils in the *My Documents/My Shapes* folder created by Visio. This will make them available to you in the Visio Shapes menu under MY SHAPES.

- If you have a number of stencils, you can create folders and sub-folders to have Visio build a menu structure.
- Due to a limitation of Visio, it is not possible to have your custom stencils appear in the Designer stencil menu structure.

**Sharing Custom Stencils**

If multiple people are creating stencil shapes, it is likely they’ll want to share them. The master version of these custom stencil files can be placed on the server so that all users will get the latest version automatically when they next start Smartware Studio.

- The stencil files should be stored on your server in the *Resources\DS Stencils* sub-folder.
5. System Names and the System List

The System Name field in the Smart Shapes allows you to group parts together into a logical system within a drawing (e.g. AHU1, VAV2, etc.). There are a number of features of Designer that make use of these names:

- The Bill of Material shape and reports allow you to sort on the System Name
- The Reports allows you to select specific systems to include in the reports
- The Typical Of values allow you to automatically multiply the quantities of the parts in a system by a value.

Specifying the System Name

You can type the System Name directly into the list box in the Shape Properties dialog. Once you use a system name, it should automatically appear in the list for the next shape.

- You should avoid using very long System Names (more than 30 characters) or using special characters in the System Names.

The System List

In older versions of Designer, it was necessary to tell Designer to scan the parts to update the System List presented in the Shape Properties dialog. In current versions, this list is updated automatically whenever necessary. The DESIGN TOOLS menu still contains the UPDATE SYSTEM LIST command, thought it should no longer be required.
Finding and Replacing System Names

If you want to change the System Name in more than one shape, select SYSTEM NAMES ➔ FIND AND REPLACE SYSTEM NAMES from the DESIGN TOOLS menu.

Sub-Systems

Though not common, you can actually further assort the parts in a system by specifying a Sub-System name. The format for these System Names are: System.SubSystem (e.g., VAV1.EF1). When you run a Bill of Material, you can choose to sort the parts by the system or the sub-system.

The parts in a sub-system are still part of the system. For example, parts in systems VAV1, VAV1.EF1 and VAV1.EF2 will display in three groups when sorted by sub-system, but will all appear under the system VAV when sorted only on system.

You cannot create sub-sub-systems.

Typical Of Values

One of the most important uses of System Names is to assign a Typical Of value to the system. This will serve to automatically multiply the quantities of the parts in the system by this value.

To prevent a part in a system from having its quantity extended, check it’s Not Typical checkbox in its Part Properties dialog.
Setting the Typical Of Value for a System

You can set the Typical Of value for a System by:

- Selecting SYSTEM NAMES → CHANGE TYPICAL OF VALUES FOR SYSTEMS from the DESIGN TOOLS menu.

- Dragging in a Typical Of shape from the Page Add Ins stencil

Smart Charts

Smart Charts are an advanced feature that allows you to specify unique information for each instance of a controller in a Typical Of scenario. The number of rows in the Smart Chart is tightly linked to the Typical Of value of the system. Refer to the later chapter on Smart Charts for more information.
6. Valve, Damper and Air Flow Schedules

While there are features of Designer that allow you to show dampers and valves directly on the drawing page, the preferred way of adding these parts to your projects and their Bill of Materials is to use a Schedule. A schedule is created and edited using Microsoft Excel, making it easy to enter, format and customize. When creating Valve Schedules, you also have the interactive Valve Sizer and Selector to help you find the body or assembly you’re looking for.

Valve Schedules
Valve Schedules are a powerful tool for sizing and creating a list of valves for your project.

Creating a Valve Schedule
To create a new schedule, right click on a Schedules folder (or in the blank area of its Files tab) and select NEW → VALVE SCHEDULE:
• The new valve schedule will be created by duplicating the Valve Schedule template, which you can customize. Refer to the chapter on *Customizing Designer*.

**Opening the Valve Schedule**

To open a valve schedule, simply double-click it in the File List, or right-click on the file name and select OPEN.

When you open the Valve Schedule, there will be three windows open:

• The Valve Schedule Options Dialog
• The Valve Schedule Workbook (in Microsoft Excel)
• The Valve Sizer and Selector

**The Valve Schedule Options Dialog**

The Valve Schedule Options Dialog controls the interaction between the other windows and the Project Explorer. It also allows you to turn the automatic lookup of parts in the database on and off. You can generally ignore this window.

![Valve Schedule Options Dialog](image)

**The Valve Schedule Workbook**

The Valve Schedule is an Excel Workbook in which you add valve parts, either by hand, or with the help of the Valve Sizer and Selector.
The columns and regions of the Valve Schedule spreadsheet are described in detail later in this chapter.

**The Valve Sizer and Selector**

The Valve Sizer and Selector is a dialog that shows all the Valve Bodies and Assemblies in the Parts Database. With it you can:

- Browse by Part Number
- Filter by Manufacturer
- Calculate a Cv and filter on a range
- Choose between valve bodies and assemblies
- Filter on all the physical characteristics of the valve body
- Filter on all the characteristics of the actuator (for assemblies)
- View detailed information on the filtered list of parts
- View product information PDF files
- Add a selected part to the Valve Schedule Spreadsheet
As you select any of the filter values, the list will be reduced to only the parts that match all the selected filters. The count of matching parts is shown in the lower left corner. You can reset the filters at any time by pressing the **RESET FILTERS** button.

In the part list you can click on any column heading to sort by that column. If you scroll the list to the right, you will see detailed information on each of the parts in the list, including most of the filterable valve body and actuator property values.

When you have found the part you want, select it in the list and click the **ADD TO SCHEDULE** button. The Part Number and other details will be copied to the next line in the Valve Schedule spreadsheet.

**Calculating a Cv Range**

To include a Cv range in your filters, check the box in the Cv Rating region:
You can enter a Cv value directly. The range will automatically be computed based on the lower and upper percentages, which can be adjusted.

To calculate the Cv value, click on the CALC… button.

The Valve Schedule Worksheet
There are a few things to note about the Valve Schedule Worksheet.

- There is a DESIGN TOOLS menu added to Excel when the Valve Schedule is open. In Excel 2010 you will find this on the ADD-INS tab of the ribbon.
- The first dozen or so rows of the worksheet are a header region. You can fill in whatever information you wish in here (or customize the template, as described later in this chapter).
- The Project Properties region of the heading can be automatically populated with the Project Properties set when you created the project by selecting INSERT PROJECT PROPERTIES from the DESIGN TOOLS menu, or by right-clicking in one the property cells and selecting INSERT PROJECT PROPERTIES from the pop-up menu.
- Columns shown with red and blue text, such as the first column (Item Number) are calculated automatically as rows are created or removed. Do not change these values by hand.

Adding Valves to the Schedule
To add a valve to the schedule you can:

- Select a valve in the Valve Sizer and Selector window; or
- Enter the part number of the body or assembly in the Part Number column (or copy and paste a value into the cell)
When a part number is entered in the spreadsheet, Designer looks the part number up in the database and automatically fills in other fields, such as the actuator part number, the spring range, and the valve size. It also updates the Item Number column and adds borders around the cells in the row as appropriate.

You can disable the automatic lookup of the detail columns from the Valve Schedule Options dialog (select DESIGN TOOLS→OPTIONS to bring it up).

**Removing Valves from the Schedule**

To remove a valve from the schedule, DO NOT delete the row in the spreadsheet. This will cause the calculated cells to become invalid. Instead, simply erase the value from the Part Number cell. The rest of the cells will be cleared automatically, and the borders will disappear as necessary.

**The Valve Schedule Columns**

There are four types of columns in the schedule:

- **User** Values to be entered manually
- **Calc** Values that are calculated automatically based on other values in the row. These are shown in red and should not be changed by hand.
- **Data** Values that are looked up in the database based on the valve part number and then filled into the row automatically. They are shown in blue and generally don’t need to be changed by hand (though you can if you want).
- **List** Values that are selected from a drop-down list that appears when you click in the cell.

The valve columns are:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Item</em></td>
<td>Calc</td>
<td>The item number in the schedule (automatically filled in and updated as you enter parts)</td>
</tr>
<tr>
<td><em>System</em></td>
<td>User</td>
<td>The system name for the part, as used by the Project Explorer in such features as the Reporting Engine to subcategorize parts. Corresponds to the System Name field in most Designer Suite shapes.</td>
</tr>
<tr>
<td><em>Tag</em></td>
<td>User</td>
<td>The Bill of Material tag for the part, as shown on material reports</td>
</tr>
<tr>
<td><em>Qty</em></td>
<td>User</td>
<td>The quantity for the part, as shown on material reports.</td>
</tr>
<tr>
<td><em>Service</em></td>
<td>User</td>
<td>The service for the part (not used by Designer Suite)</td>
</tr>
</tbody>
</table>
### Valve, Damper and Air Flow Schedules

**Part #**  
User  
The part number for the body or assembly. Entering a value in this cell causes other cells to be filled in automatically. Clearing this cell will clear the other values from the row.

**Actuator**  
Data  
The part number of the actuator for the specified assembly.

**Spring Range**  
Data  
The spring range of the assembly

**Pos. Posit**  
Data  
Indicates if the assembly has a positioner.

**Valve Type**  
Data  
The pattern type of the valve (e.g. Two-Way Straight).

**Valve Size**  
Data  
The size of the valve body.

**Pipe Size**  
List  
The size of the pipe, for use in Cv calculations.

**Valve Action**  
Data  
An indication of the valve’s fail safe position.

**Conn. Type**  
Data  
The connection type of the valve.

**Flow GPM**  
User  
Used to calculate the valve Cv

**#/HR**  
User  
Used to calculate the Valve Cv

**Cv Calc**  
Calc  
The calculated Cv of the valve

**Cv Actual**  
Data  
The actual Cv of the valve

**Press. Drop**  
Calc  
The calculated pressure drop

**Stem Up**  
Data  
The Stem Up Close off value

**Stem Down**  
Data  
The Stem Down Close off value

**Piping Detail**  
List  
The piping detail diagram for the value (used to create a Valve Legend)

---

**Piping Detail**

In the Piping Detail column you can pick from a list of coded piping detail diagrams. Each code corresponds to a configuration from the following list (which you can view on the DATA worksheet tab included in the Valve Schedule workbook)

- 3C01  3-Way Mix Cool Small N.O.
- 3C02  3-Way Mix Cool Small N.C.
- 3C03  3-Way Mix Cool Erie N.O.
- 3C04  3-Way Mix Cool Erie N.C.
- 3C05  3-Way Divert Cool Small N.O.
- 3C06  3-Way Divert Cool Small N.C.
- 3H01  3-Way Mix Heat Small N.O.
- 3H02  3-Way Mix Heat Small N.C.
- 3H03  3-Way Mix Erie N.O.
- 3H04  3-Way Mix Erie N.C.
### System Names and the System List

<table>
<thead>
<tr>
<th>Piping Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3H05</td>
<td>3-Way Divert Heat Small N.O.</td>
</tr>
<tr>
<td>3H06</td>
<td>3-Way Divert Heat Small N.C.</td>
</tr>
<tr>
<td>3C07</td>
<td>3-Way Divert Cool Erie N.O.</td>
</tr>
<tr>
<td>3C08</td>
<td>3-Way Divert Cool Erie N.C.</td>
</tr>
<tr>
<td>3C09</td>
<td>3-Way Divert Cool Large N.O.</td>
</tr>
<tr>
<td>3C10</td>
<td>3-Way Divert Cool Large N.C.</td>
</tr>
<tr>
<td>3C11</td>
<td>3-Way Ball Cool Divert</td>
</tr>
<tr>
<td>3H07</td>
<td>3-Way Divert Heat Erie N.O.</td>
</tr>
<tr>
<td>3H08</td>
<td>3-Way Divert Heat Erie N.C.</td>
</tr>
<tr>
<td>3H09</td>
<td>3-Way Divert Heat Large N.O.</td>
</tr>
<tr>
<td>3H10</td>
<td>3-Way Divert Heat Large N.C.</td>
</tr>
<tr>
<td>3H11</td>
<td>3-Way Ball Heat Divert</td>
</tr>
<tr>
<td>2C01</td>
<td>2-Way Cool CHWS</td>
</tr>
<tr>
<td>2C02</td>
<td>2-Way Cool CHWR</td>
</tr>
<tr>
<td>2C03</td>
<td>2-Way Erie Cool CHWS</td>
</tr>
<tr>
<td>2C04</td>
<td>2-Way Erie Cool CHWR</td>
</tr>
<tr>
<td>2H01</td>
<td>2-Way Heat HWS</td>
</tr>
<tr>
<td>2H02</td>
<td>2-Way Heat HWR</td>
</tr>
<tr>
<td>2H03</td>
<td>2-Way Erie Heat HWS</td>
</tr>
<tr>
<td>2H04</td>
<td>2-Way Erie Heat HWR</td>
</tr>
<tr>
<td>2C05</td>
<td>2-Way Cool Coil Pump</td>
</tr>
<tr>
<td>3C12</td>
<td>3-Way Cool Mix Coil Pump N.O.</td>
</tr>
<tr>
<td>3C13</td>
<td>3-Way Cool Mix Coil Pump N.C.</td>
</tr>
<tr>
<td>2H05</td>
<td>2-Way Heat Coil Pump</td>
</tr>
<tr>
<td>3H12</td>
<td>3-Way Heat Mix Coil Pump N.O.</td>
</tr>
<tr>
<td>3H13</td>
<td>3-Way Heat Mix Coil Pump N.C.</td>
</tr>
</tbody>
</table>

This piping code is used when creating a Valve Legend for your project. The diagrams are taken from the ValveDetails.vss stencil in Visio. Refer to the later chapter on the Valve Legend tool for more detail.

### Air Flow and Damper Schedules

You can create Air Flow and Damper Schedules in the same way as you do Valve Schedules. The main difference is that there are no Air Flow or Damper parts in the Parts Database, so there is no selection dialog or automatic filling-in of fields based on the part numbers.

The Air Flow and Damper parts can, however, be added to the Bill of Materials, if the schedule is saved in a scannable folder as noted below.

### Including Schedule Parts in the Bill of Materials

The schedules can often stand by themselves, but there are times when you want the parts to be included in Designer Suite project reports, such as a Total Bill of Materials. To ensure that the parts in the schedule are added to the database of parts accumulated from
Visio drawing files, be sure that the schedules are saved in a Schedules folder. Refer to the earlier chapter on Creating a new Designer Project for more details.

Customizing the Schedules

The template Excel files that are used for the Valve, Damper and Air Flow Schedules are fairly sophisticated in that they allow Designer to read the part information into the project’s database to include the parts in material reports. You should exercise some caution when editing these files. It is recommended that you not insert or remove rows or columns, as Designer expects to find certain information in specific cells.

Refer to the chapter on Customizing Designer for information on how to create, point to and distribute custom template files.

If you do want to make more sophisticated changes, you can modify the underlying locations of the data by viewing the DsScheduleProperties worksheet, which is normally hidden:

To Expose the DsScheduleProperties Worksheet

While editing your copy of the schedule template file in Excel, select FORMAT→SHEET→UNHIDE (in Excel 2003) or right-click another tab at the bottom of the workbook and select UNHIDE (in Excel 2007 or later)

Select the worksheet and click OK.

The DsScheduleProperties worksheet contains the properties that tell Designer Suite important information such as:

- Where the first row of parts is (Data.FirstRowNumber)
- Where the last relevant column is (Data.LastColumnNumber)
- Which columns contain which fields (e.g., Fields.MfgPartNumber.ColumnNumber)
System Names and the System List

- Where the Project Properties should be placed (e.g. Fields.ProjectName.RowNumber and Fields.ProjectName.ColumnNumber)

If you move the columns and rows around in the schedule, you should ensure that the values specified here are also changed accordingly.
7. Customizing Designer

There are a number of features of Designer that allow you to customize and enhance the built-in elements, and make it easy to distribute your customizations to all the users in your organization.

Storing and Distributing Customized Files
In most cases, the custom files you create (reports, templates, parts databases) are handled the same way:

Local Files
A copy of the custom data is stored on each workstation

For Windows XP, the main folder is usually:
C:\Documents and Settings\All Users\Application Data\Smartware Studio\n
For Windows 7, the main folder is usually:
C:\ProgramData\Smartware Studio\n
In both cases, these folders are normally hidden by Windows, so you may need to tell Windows Explorer to show hidden files and folders in order to view it.

There are various sub-folders in this folder that store the different types of files:

\Custom Templates Custom versions of the Designer templates (e.g., Blank Drawing, Valve Schedule, etc.)
\Reports\Design Reports for the new version of the Report Engine
\Reports\Designer Suite Reports for the older DS 2005 Reports tab
\System Libraries Single-File and Multi-File Libraries

As described in the next sections, you can put your custom files into these folders on your workstation to make them available to your workstation (but not other users).

Server Files
Smartware Studio stores all its server files (project data, configuration data and custom files) in a single folder structure on your server that was set up by your administrator.

- You can determine the location of this folder on your network by selecting TOOLS→OPTIONS and reviewing the Server Settings tab.
In your server folder is a sub-folder called *Resources*. This folder contains other sub-folders where *distributable versions* of your custom files can be stored. Any time a user starts Smartware Studio, their workstation looks to these folders and copies any new or updated files into the appropriate folders on the workstation.

For example, if your server folder was

```
\OurServer\Smartware Studio\n```

then your Resources folders would be

```
\OurServer\Smartware Studio\Resources\n```

and your custom templates would be stored in

```
\OurServer\Smartware Studio\Resources\Custom Templates
```

The files in this server folder would be synchronized down to each workstation’s local `\Custom Templates` folder.

Once you have created a customized file (as described in the next sections), you can distribute it to all the users in your organization by simply copying it into the appropriate Server Folder.

- Files in the Server Folder that don’t exist on the user’s workstation, or files on the server that are newer than version on the workstation, are automatically copied to the workstation when Smartware Studio is started.
- Files that are modified on the workstation will neither be overwritten nor automatically uploaded back to the server. Updated versions will need to be copied to the Server Folder manually.

### Custom Template Documents

There are six documents used by Designer that, when added to your project, are created by duplicating a Template version of the document. These are:

- Blank Drawing (Visio)
- Table of Contents (Visio)
- Valve Legend (Visio)
- Valve Schedule (Excel)
- Air Flow Schedule (Excel)
- Damper Schedule (Excel)
It is common to create customized versions of these files that may include, among other changes, your company’s logo and address. To do so, you will want to following a simple procedure of copying the default version of the template to a new name (e.g. *Acme Valve Schedule*), modifying the copy and distributing then that new file to all the users.

- You must not modify the template files that are installed with Smartware Studio. These files are likely to be erased and/or updated by new installations.

**Custom Template Locations**

The installed versions of the template files are located in the *Templates* sub-folder of your workstation’s installation directory, such as:

```
C:\Program Files\Smartware Technologies\Smartware Studio\Templates\Visio
C:\Program Files\Smartware Technologies\Smartware Studio\Templates\Excel
```

When you duplicate one of these files, you should copy it into your *Custom Templates* folder, as described earlier in the chapter. For example, on Windows XP this is usually:

```
C:\Documents and Settings\All Users\Application Data\Smartware Studio\Custom Templates
```

Finally, to distribute it to all users in your organization, copy it to the distribution folder on your server, such as:

```
\OurServer\Smartware Studio\Resources\Custom Templates
```
Selecting a Custom Template

You can specify the specific file to use as a template for each type of file you create in Designer by going to the TOOLS→OPTIONS dialog and the Designer tab:

- Whereas in Designer Suite 2005 you could browse to each file in separate folders, here you are given a list for each document of the installed version of the files and any files you have stored in your Custom Templates folder.
- An administrator can select the choices for all users in an organization (see next section), and determine if each user can override these selections.

Distributing and Auto-Selecting Custom Templates for an Organization

If you are an Administrator for your organization, you can specify the templates that each user should have selected. This reduces the amount of setup you need to do for each user’s workstation and ensures everyone is using the same template files.
To control the distribution, select **ADMIN → DESIGNER MODULE MANAGEMENT**: 

- There are quick links to the locations where Custom Template files are stored on the server and on the workstation.
- Once copied onto the server, the template files can be selected. These files and selections will automatically push down to each workstation the next time they start Smartware Studio.
- There are options that allow you to decide if each user can override these selections.

**Customizing the Blank Drawing File**

When you ask Designer to insert a new blank Visio Drawing file, it begins with a copy of the file listed as **Blank Drawing** in the **TEMPLATE FILES** preferences. You can create a custom version of this file to include a set of stencils that should always be opened by default, or other standard drawing elements such as a title block.

You must always start your customizations on the default version included with Smartware Studio (**Blank Designer Suite Drawing.vsd**), which contains underlying program code necessary for the drawing to communicate with the Project Explorer.

Custom Blank Drawing files created with Designer Suite 2005 should work unchanged, as they will be upgraded automatically when they are opened.
Customizing Valve, Damper and Air Flow Schedules

The template Excel files that are used for the Valve, Damper and Air Flow Schedules are fairly sophisticated in that they allow Smartware Studio to read the part information into the Project Database to include the parts in material reports. You should exercise some caution when editing these files. It is recommended that you not insert or remove rows or columns, as Designer expects to find certain information in specific cells.

If you do want to make more sophisticated changes, refer to the earlier chapter on Valve, Damper and Air Flow Schedules.

Custom Visio Stencils

As described in the earlier chapter Working with Stencils and Smart Shapes, you may create custom stencils to hold:

- Custom Visio Shapes
- Custom Smart Clone Shapes
- Customized versions of Designer shapes (such as the Title Block)

Visio Stencil Files Locations

In Designer Suite 2005, custom stencils are stored in the same folder as the installed Designer Suite 2005 stencils (generally C:\Program Files\Designer Suite 2005\Stencils).

Your custom Visio Stencils should be stored in Visio’s preferred location:

FILE\My Documents\My Shapes

By copying your stencils here, they will appear off the MY SHAPES menu at the top of the Visio Shapes menu:
You can create your own menu structure by creating sub-folders in the *My Shapes* folder. In this case, the *Acme Shapes.vss* file was stored in:

\My Documents\My Shapes\Security Group\Acme Shapes.vss

- Smartware Studio does not rely on the Visio Stencil path as Designer Suite 2005 does.

**Creating and Using Custom Stencils and Shapes**

You can create your own shapes, either from scratch (as Smart Clones) or by modifying an existing shape from a Designer stencil. If you do, there are several critical rules you must follow:

- Never store your shapes in the Designer stencil files. These files will be overwritten every time Designer is updated.
- Never copy one of our stencil files to use for storing your shapes. Our stencils contain underlying code and names that may conflict with themselves if duplicated. Moreover, if this code changes significantly, those custom versions will be out of date and cause further conflicts.
- Always store your shapes in blank stencils created from Visio.
- Never name your stencil files with the same name as one of the Designer Suite standard stencils

**Distributing Custom Stencils**

To distribute custom Visio stencils to all of the users in your organization, copy them to your server’s Resources folder, such as:

\OurServer\Smartware Studio\Resources\DS Stencils

The stencil files in this folder will automatically be copied to each user’s \My Documents\My Shapes folder when Smartware Studio is launched.

**Customizing the Title Block Shape**

One of the most common customizations is to add your corporate logo to the title block shape included on the *PAGE ADD INS* stencil. If you do so, you should follow these procedures to prevent your title block from behaving improperly. An understanding of the concepts behind Visio’s stencils and groups will be helpful.
1. Create a new blank stencil in Visio
   a. File → Stencils → New Stencil (Visio 2002);
   b. File → Shapes → New Stencil (Visio 2003 and 2007);
   c. (Shapes Panel) More Shapes → New Stencil (Visio 2010)

2. Open the Page Add Ins stencil.
3. Right-click on the Title Block shape and select Copy.
4. Select your new stencil, right-click and select Paste. This will insert a new master into your new stencil.
5. Right-click on the new title block master and select Edit Master → Master Properties. You can then specify a new name for your custom title block shape, along with other properties. Click OK when you are done.
6. Right-click on the new title block master again and select Edit Master → Edit Master Shape. The title block shape will be shown in a new window surrounded by a different background color to indicate that you are editing a master shape. You may need to minimize other windows to make it easier to work with the master.

The title block shape is a group containing a number of other shapes inside of it, such as the large border, the logo and the Job Information block. Only the group shape is selectable.

7. Select the group, which will cause a dotted line to appear around the entire title block.
8. Open the group shape:
   a. In Visio 2007 or earlier, from Visio’s Edit menu, select Open Title Block.
   b. In Visio 2010, right-click on the shape and select Group → Open Title Block.

The title block will appear in another new window (with a pale yellow background in older versions of Visio to indicate that you are editing the contents of a group).

While editing the contents of the group, each of the individual elements are selectable and can be moved, changed or deleted. It is strongly recommended that you restrict your customizations to the logo and address in the upper right corner of the title block.

9. Insert your company’s logo and resize and position it accordingly. Change the text object beneath it to include your company address and phone number as desired.
10. Close the yellow-background window showing the group’s contents.
11. Close the green-background window showing the master’s contents. You will be prompted to save the changes you made to the master.

12. On your new stencil, click on the small document icon with the red asterisk to bring up the stencil’s menu and select SAVE. Specify a new file name for your custom stencil. You may feel free to save it into Designer Suite’s STENCILS directory (or better yet, a sub-folder of this directory), which will make it easier to find, but you must not save over the existing PAGE ADD INS stencil.

You should make sure to not do the following:

- Do NOT create your custom stencil by copying an existing Designer stencil. These stencils contain program code that should not be duplicated in multiple stencils. Instead, add your master to a new blank stencil as described above.
- Do NOT add your custom title block to the existing PAGE ADD INS stencil. If you do, you will lose your custom version the next time this stencil is updated.

If you are having difficulty creating a custom title block, you can forward the appropriate information and graphics files to us at techsupport@smartwaretech.com and we will be happy to create a custom stencil for you.

**Custom Reports**

The later chapter on Reports describes how to create custom report templates. To use your custom report templates on your workstation, copy them into your Local folder (as described earlier in this chapter):

For Windows XP, the folder is usually:

\Documents and Settings\All Users\Application Data\Smartware Studio\Reports\Designer

For Windows 7, the folder is usually:

\ProgramData\Smartware Studio\Reports\Designer

To distribute the report templates to all users automatically, copy them to your server’s distribution folder, such as:

\OurServer\Smartware Studio\Resources\Reports\Designer
Custom Parts

Smartware Studio introduces a new Parts Database Manager. The key new features are:

- The entire Parts Database is stored in your SQL Server database.
- With a single button click you can synchronize all the parts and prices to the central Smartware version of the Parts Database.
- With another single button click you can distribute a copy of the Parts Database to all the users in your organization.
- You can add and edit custom parts on an individual basis.
- You can import a set of parts from an Excel worksheet using an updated Import Template.
- You can update values in a set of parts from an Excel worksheet.

You should read the *Parts Database Manager* chapter in the *Setup and Administration Guide* for full details on how to initialize, configure, update and distribute the Parts Database.
8. Page Add Ins

The Page Add Ins stencil contains a number of shapes that don’t represent parts, but instead provide documentation and help Designer interact with Visio, including

- Title Blocks
- Bill of Material
- Typical Of Value
- Revision Bubbles

Title Blocks

The Title Block shape is generally the first shape you add to a drawing page.

Aside from its appearance, the title block serves an important function in Designer. When working with pages in such tools as the Page Wizard, Print Manager and Table of Contents, only pages with a title block shape are considered and the title block provides the page number.
The Title Block Information

The edge of the title block shape provides a set of information that you can edit by double-clicking the shape or right-clicking and selecting EDIT TITLE BLOCK from the menu.

- The majority of the properties can be imported from the Project Properties by clicking the LOAD FROM PROJECT button. The title block is not automatically updated if the Project Properties change.
- The Page Number and Page Count (e.g., 1 of 2) should both be numbers (i.e., do not include letters, such as 15a) to ensure they are sorted properly by other tools.
- When you click OK, the changes will be applied to the selected title block only.
- To apply the values to each title block on every page in the entire drawing file, click UPDATE ALL PAGES.
### Updating Title Blocks in Multiple Drawings

There are other Designer tools that allow you to update multiple title blocks at once:

- The Page Wizard is used to update, change and renumber the pages and system names in multiple files.
- The Revision Notes tool is used to remove or add a Revision Note and Date to the title blocks on multiple pages.

Refer to the later chapters on these tools for more information.

### Bill of Material Shape

It is very common to want to show a list of the material shown on a drawing page directly on the page. The Bill of Material Shape does just that.

<table>
<thead>
<tr>
<th>AC-2</th>
<th>Device</th>
<th>Qty</th>
<th>Part Number</th>
<th>Description</th>
<th>Vendor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Electrical</td>
<td>1</td>
<td>FUN-RIB24-01C</td>
<td>ENCLOSED RELAY 16AMP SPDT 24VAC</td>
<td>SINGLE SOURCED SOLUTIONS</td>
</tr>
<tr>
<td></td>
<td>Electrical</td>
<td>1</td>
<td>FUN-RIB24-01D</td>
<td>ENCL RELAY 10A DPDT 24VAC</td>
<td>SINGLE SOURCED SOLUTIONS</td>
</tr>
<tr>
<td></td>
<td>R51-7</td>
<td>7</td>
<td>.51K</td>
<td>511 OHM RESISTOR</td>
<td>LOCAL VENDOR</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AC-2</th>
<th>Device</th>
<th>Qty</th>
<th>Part Number</th>
<th>Description</th>
<th>Vendor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Electrical</td>
<td></td>
<td>TS-0422</td>
<td>ZZ AVG. SENSOR 1 K OHM BALCO</td>
<td>INVEINSYS BLDG SYSTEMS</td>
</tr>
<tr>
<td></td>
<td>Electrical</td>
<td>1</td>
<td>TS-0422</td>
<td>ZZ AVG. SENSOR 1 K OHM BALCO</td>
<td>INVEINSYS BLDG SYSTEMS</td>
</tr>
<tr>
<td></td>
<td>Panel</td>
<td>1</td>
<td>MIN-1000</td>
<td>1/A SERIES MAGNET PLANT CNTRL</td>
<td>INVEINSYS BLDG SYSTEMS</td>
</tr>
<tr>
<td></td>
<td>U1055002</td>
<td>1</td>
<td>MIN-1000-ENG</td>
<td>WALL MNT ENCLOSED FOR MIN-1000</td>
<td>INVEINSYS BLDG SYSTEMS</td>
</tr>
<tr>
<td></td>
<td>TOP-1</td>
<td></td>
<td>VER-E52-1000-5</td>
<td>ELECT-PNEU TRANSOUER P51</td>
<td>SINGLE SOURCED SOLUTIONS</td>
</tr>
<tr>
<td></td>
<td>TOP-1</td>
<td></td>
<td>AE-690</td>
<td>AUX EQUIPMENT PANEL 16-3/3 X 8</td>
<td>INVEINSYS BLDG SYSTEMS</td>
</tr>
<tr>
<td></td>
<td>F1</td>
<td>1</td>
<td>K-335</td>
<td>FINAL FILTER W/OIL INDICATION</td>
<td>SINGLE SOURCED SOLUTIONS</td>
</tr>
<tr>
<td></td>
<td>TCP-1</td>
<td>1</td>
<td>FUN-TR1001VA401</td>
<td>TRANSFORMER, 100 VA 120/240VAC</td>
<td>INVEINSYS BLDG SYSTEMS</td>
</tr>
<tr>
<td></td>
<td>XTHM-3</td>
<td>1</td>
<td>TR50VA005</td>
<td>TRANSFORMER, 50 VA 120/240VAC</td>
<td>SINGLE SOURCED SOLUTIONS</td>
</tr>
</tbody>
</table>

To add a Bill of Material, drag the shape from the Page Add Ins stencil:

**BOM Generator: Designer**

Right-Click and choose "Update Bill of Material" to generate Bill of Material List.
Next, right click on the shape and select **UPDATE BILL OF MATERIAL** to specify how you want the Bill of Materials to be sorted and which parts to include:

![Bill of Materials](image)

The Bill of Material shape does not automatically update as you add or remove parts from the drawing. You will need to right-click on the shape and run the update again as necessary.

**Typical Of Value**

The Typical Of Value of a system was described in the previous chapter. As noted, the Typical Of shape from the Page Add Ins stencil can be used to annotate the Typical Of value as well as set it.
Be aware that this shape does not automatically update if the Typical Of value is change through a different action, such as with the Site Manager or by using the DESIGN TOOLS→SYSTEM NAMES→CHANGE TYPICAL OF VALUES FOR SYSTEMS menu command. If you do change it elsewhere, you can double-click this shape again and click OK to update the shape’s text.

Revision Bubbles
To show the specific changes that were made in a revision, you can encircle them with one of the two Revision Bubble Shapes.

When you use the Revision Notes feature to clear the revision notes from the Title Block, you will also have the option of removing these bubbles automatically.
9. The Smart Shapes

Designer contains hundred of shapes that can be used on your drawings. They fall into a few different categories:

- Generic items, such as duct work and piping, with no specific part numbers
- Generic parts that are not normally found in the Parts Database, such as computer equipment
- Smart shapes that can represent a whole category of database parts, such as relays and transformers
- Smart shapes that represent a specific, individual part, such as the Functional Devices relays

Generic Shapes
There are a number of stencils that contain shapes that don’t represent specific parts.

Duct Shapes (Duct.vss)
The Duct stencil contains various pieces of duct work, as well as fans, filters and other similar shapes. Many of these shapes are resizeable, and many show the scaled dimensions inside the shape, updated as you resize them.
**Water Shapes (Water.vss)**

The Water stencil contains shapes for piping, boilers, heat exchangers, cooling towers and other similar features. Many of these shapes are resizable, and are designed to snap to one another’s connection points to provide automatic resizing and re-routing as you move them.

In many cases, you can change the color of the shape by right-clicking on them and selecting SET SERVICE/MEDIA COLORS. Other shapes have menu commands that allow you to change their configuration, such as the Boiler which allows you to switch the supply and return connections.

**Computer Devices (Computer Devices.vss)**

The Computer Devices stencil contains generic Smart Shapes for computer hardware and peripherals. You can set the Part Number, Bill of Material and other properties as you would other shapes, though the default Parts Database does not contain any specific parts.

You can add specific computer parts to the Parts Database using the Database Manager.
Other Generic Shapes
Other stencils that contain less common shapes and components include:

- Installation Materials
- Pieces and Parts

Part Specific Smart Shapes
Many of the Designer stencils and shapes are designed to represent specific parts from the Parts Database. You can also code your custom parts added with the Database Manager to be available in the part lists viewed with these shapes.

Relays (Relays.vss)
There are two different standard relays, including the more common Point-To-Point Relay shape. This shape can redraw itself in various ways to represent one or two coil, one to four pole, and single or double throw. These properties are pulled from the Parts Database as you select a part, but they can also be set explicitly on the Relay Configuration tab of its Part Properties dialog.
**Function Devices Relays (Functional Devices.vss)**

There is a separate stencil containing many of the more common Functional Devices relays, with specific wiring information:

![Function Devices Relays Diagram](image)

**Power Supplies (Power Supplies.vss)**

The Power Supplies stencil contains shapes for Transformers (with database driven terminal wire colors), Power Supplies and the specific PRK-FS panel receptacle.

![Power Supplies Diagram](image)
**Safety Devices (Safety Devices.vss)**

The Safety Devices stencil includes a Low Limit and High Limit Thermostat shape. The terminals are database driven, and custom parts added to the Parts Database can set these values as well.

**Starters (Starters.vss)**

The Starter shapes (e.g. One Phase, Three Phase, etc.) are actually a combination of a number of other Smart Shapes, including I/O Points, relays, transformers and fans.
You can set the properties on the individual components, as well as on the starters as a whole. To access the starter properties, right click on the entire starter group shape and select STARTER INFORMATION from the menu.

**Actuators (Actuators.vss)**

There are hundreds of actuator parts in the Parts Database, and a number of different shapes that can be used to represent the different types. Designer includes a powerful browse dialog that can be used to search this catalog by many properties, such as Manufacturer, Product Line, Actuator Type, Signal Type and Power Source.

- As you select specific values for these filters, the part list will be reduced to show only those that match.
- The part list contains columns showing these property values for each part in the filtered list.
- You can use this dialog to view the PDF Product Information Sheet for the parts.
- You can also access this Actuator Selector from Smartware Studio by selecting TOOLS⇒PARTS⇒BROWSE VALVES AND ACTUATORS…
Adding an Actuator

The easiest way to add an actuator is to drop the Find an Actuator shape onto your drawing and then double-click it (or right-click it and select SELECT ACTUATOR from its menu). You will be presented with the Actuator Selector, and when you select an actuator the Find an Actuator placeholder shape will be replaced with the appropriate specific actuator shape.

The wiring, terminal colors and terminal label values are stored in the Parts Database, and will be updated to reflect the selected part.
10. Controllers and Devices

One of the most powerful categories of shapes in Designer is the device shapes. By allowing you to implicitly connect sensors, transmitters and I/O points to the specific Analog and Digital I/O points on a controller, you can create controller checkout sheets, along with a wide range of other reports and error checking.

Device Shapes

A device is a shape that represents a controller or other sophisticated part that has analog and/or digital I/O points that can be connected to external sensors or similar components. Device shapes available in Designer include the following Schneider Electric product lines:

- StruxureWare
- I/A LON
- I/A BACnet
- Network 8000
- Continuum
- Xenta
- Niagara R2 and Ax

Device Shape Properties

The Part Properties dialog for a device shape will include a number of additional sets of fields not found in standard parts:

- Device Address Information, such as Neuron ID, Network Number or IP Address.
- Communication fields that indicate the other devices that the controller is connected to (From Device and To Device)
- Power Connection values, and a checkbox to indicate if they should be displayed on the shape.
- Detailed I/O Point information.
I/O Points
For each I/O point on a controller, you can enter the information for the point in two ways.

- You can enter it directly on the appropriate I/O tab of the controller’s part properties dialog.
- You can create an I/O Point (or drop a sensor shape) and point to the specific controller and point. You can then go back to the controller and do an Auto Insert to find the I/O points and populate the controller’s I/O tab automatically).
**I/O Point Shape**

The I/O Point shape can be found on the *Sensors and Transmitters* stencil. When you double-click it, you can select the properties:

- The *Point Type* (i.e. 10K Thermistor or 0-20mA) is used during error checking to verify a valid point type connection.
- The *Software Tag* is carried over to and shown on the controller during an Auto Insert. The list of valid tags is pre-defined by Designer, but can be customized as part of the User Database (refer to the earlier chapter on *Customizing Designer*).
- The *Device* allows you to select from the existing device shapes in the drawing file.
- The *Point* fields allow you to select from the available points of the specified type (AI, DI, AO or DO) on the specified controller.

**Sensors and Transmitter Shapes**

Other shapes on the *Sensors and Transmitters* stencil can act as an I/O point as well. The Part Properties dialog for these shapes will include fields similar to an I/O point, such as the *Software Tag*, *Device* and *Point*.
As with the I/O point, the point information appears on the shape, and will be picked up and transferred to the controller during an Auto Insert.
The Sensor shape has another tab that controls the various elements of its appearance in the drawing:

Most of the existing sensor parts in the database define these values so they are loaded automatically when you select the part. You can also change these values to create custom sensor shapes, or specify these extended properties for the sensor parts you add to the Parts Database using the Parts Database Manager.
The Controller I/O Tab Page

Each controller has one or more tabs on the Part Properties pages that allow you to specify information about the I/O points.

- The *Pt Is In Use* checkbox is generally turned off when the I/O is empty. This prevents the wire leads from showing as well.
- The *Tag ID* is the Bill of Material Tag for the I/O Point or Sensor
- The *Software Tag* is the one specified in the I/O Point or Sensor
- As shown, some controllers can indicate that the wires should have shielding or optional resistors shown on the shape. Other can display various jumpers, dip switches or connections to ground.
The controller will show the I/O information, resistors, jumpers and power connections as you set them.
**Auto Insert**

If you have created I/O and Sensor shapes and specified the controller device and point information, you can have the information copied into the controller. Simply click the **Auto Insert** button on the bottom of the controller’s Part Properties dialog.

![Auto Insert](image)

**Error Checking**

There are a number of error checks you can run on your drawing file to check for consistencies, and most involve devices. You can access these error checks from the **Design Tools ➔ Error Checking** menu.

The error checks are:

- **Missing Point Connections**
- **Invalid Point Types**
- **Duplicate Point Connections**
- **Duplicate BOM Tags**
- **Duplicate Network Addresses**
- **Obsolete Parts**

If any conflicts are found, they are reported and the shapes involved are colored to indicate the problem.

You can run the error checks individually, or you can run them all at once by selecting **Error Checking ➔ Check for All**.
**Error Colors**
The colors used to describe the errors found on the shapes are:

- Red  Duplicate Point Connection
- Yellow  Duplicate BOM Tags
- Blue  Invalid Point Connection
- Green  Missing Point Connection

You can view these codes at any time by selecting the ERROR CHECKING→EXPLAIN ERROR CODES menu item.

You can also add a list of the error color descriptions to your drawing from the Page Add Ins stencil.

**Clearing the Error Colors**
The colored shapes do not automatically revert to black when you resolve the errors. To reset a single shape, right-click on the shape and select RESET ERROR from the menu. To reset multiple shapes, select the ERROR CHECKING→CLEAR ERRORS menu item, which allows you to clear the colors for the shapes on a single page or in the entire file.

**Invalid Point Types**
The Invalid Point Type check compares the Point Type (e.g. 10K Thermistor) of the I/O point or sensor to the allowable point types for the I/O as defined by the device. With an I/O Point shape, the point type is always defined explicitly so the checks can be made. With the sensor shapes, however, the point type is defined in the Parts Database. Not every part has their I/O type defined (those not flagged as tested). In these cases, the unknown point type will cause the error checking to report the sensor as an Invalid Point Type. You can safely ignore these errors.
11. Panel Devices and Automation Overview

There are times when you will want to create a Panel layout to show how the components should be arranged. Designer has a separate class of shapes that are drawn to scale that are specifically designed for such diagrams.

Scaling in Panel Layouts
When working with panel devices and enclosures, all the shapes have been created to a 1/5 scale. If you create any custom panel shapes, you should adhere to this convention.

Enclosure Shapes
The Panel Devices stencil (Panel Devices Invensys.vss) contains an Enclosure shape that allows you to select an enclosure part from the database and then resizes itself accordingly to the dimensions specified in the database.
With dimensions of 24” x 16”, this enclosure will appear at 1/5 scale as 4.8” x 3.6” on the drawing:

Panel Device Shapes
The Page Add Ins stencil contains a Panel Device shape that can link to an existing controller in your drawing and resize itself to the proper size and scale.

- Drag the Panel Device shape onto your drawing and double-click it to bring up the properties. You will be presented with a list of the controllers in your drawing.
• Select the appropriate controller’s BOM Tag. The shape will resize.

The Panel Devices stencil also contains panel versions of a number of the older Schneider Electric controllers. Other stencils also contain scaled panel versions of schematic shapes.

The panel device shapes are not a substitute for the regular shape, and do not show up on the Bill of Materials. If you select their properties dialog, you can link the panel shape to an existing device and specify its location in the panel.
Panel Devices and Automation Overview

**Panel I/O Points (Panel IO Points.vss)**

There is also a Panel version of the I/O Point that can be used for annotation. These points look the same, but are not picked up when you do an Auto Insert from a device.

![Panel IO Points](image)

Automation Overview

Along with the panel versions, there is a third version of a number of the device shapes that are designed for creating logical automation overview diagrams. These shapes are not drawn to scale.

- For the older Schneider Electric controllers, you can find specific versions in the Automation Overview Invensys stencil:
For newer controllers, the *Page Add Ins* stencil contains generic versions (small and large) that work with any device:

You can automate the creation of the Automation Overview devices from the Smartware Studio Network Tree. Refer to the *Smartware Studio User’s Guide* for more detail.

**Power and Bus Connectors**
This stencil also contains Power Connector and Bus Connector shapes, which are resizable and snap to the connection points on the device shapes. If you right-click on the connector, you can set their text, line color and line types.

**Terminal Blocks**
Designer contains a sophisticated Terminal Block shape that can be used to create all types of wiring diagrams for use in panels. Refer to the next chapter for more information.
12. Terminal Blocks

The Terminal Blocks stencil provides shapes for drawing detailed wiring diagrams and panel images of terminal blocks populated with various components. Grouped wires, jumpers, grounded terminals, wire tags and various labels allow significant flexibility for creating a wide array of different style terminal diagrams.

Creating a New Terminal Block Shape

To create a terminal block, open the Terminal Blocks stencil and drop a Terminal Block shape onto your drawing. An empty block is represented by a simple square:

If you right click on the shape, you will see two menu items: TERMINAL BLOCK PROPERTIES, and EDIT TERMINALS.
Selecting **Terminal Block Properties** brings up the standard Properties dialog used by most Designer shapes. This dialog allows you to select the Part Number for the DIN Rail used to hold the terminal block parts.

### Adding Terminal Parts

Right click on the shape and select **Edit Terminals** from the menu. This will bring up the Define Terminal Block dialog:

![Define Terminal Block Dialog](image)

Each position on the block is represented by a row in the spreadsheet. To specify the number of rows, simply type a number into the **Number of Rows** field or click on the up and down arrows next to the field. You can also insert and delete rows using the **Edit** menu as described later.

Each row consists of five parts: The **Line Type**, the **Show on BOM** check box, the **Part Number**, the **Wire Tag** and the **Bracket**.

**The Line Type**

On one side of the block you can add groups of curved lines coming from the parts, representing bundles of wires. For each part, you can specify the line to go straight out, curve down or up to merge with other lines, or to be omitted. Lines are automatically grouped together based on their configuration, and each group can be resized with a control handle at the point that they merge and at the tip of the straight portion.
The Show on Bill of Materials Check Box

For each part, you can indicate whether you want it to be added to the Bill of Materials for the drawing. Parts are automatically grouped together by part number as single line items on the Bill of Materials with the appropriate quantities.

The Part Number

When you select the Part Number list box, you will see a list of all the available parts that can be placed on the block. Selecting the Top Parts or Tested Parts checkboxes will filter this list accordingly.

The PART LABEL text field allows you to specify a label of up to three characters to be placed on the part itself.
Terminal Blocks

If you select the first (blank) line, the position will be left blank. If you select the second (Label Only) line, only the text entered in the PART LABEL field will be shown, allowing you to create other types of schematic wiring diagrams, such as the one illustrated in the Overview.

The Wire Tag
On the other side of each part, you can specify whether you want a ground symbol, a jumper or a tagged wire to be shown:

If you select a Jumper or Double (two-line) Tag, the tag specified in the next row will be ignored. For wire tags spanning three or more parts, select Tag Start in the first row and Tag End in the last row. The Tag Label text field is used to specify the text shown in the wire tag square or next to the Jumper.

Brackets
At the edge of the tagged wire lines, you can add curved brackets with text as additional annotation:
You can specify the number of wires the bracket covers by selecting 2 Line or 3 Line from the BRACKET SIZE list box, or by selecting Start on the first row and End on the last row of the group. The text shown next to the bracket is specified in the BRACKET TEXT field. The number of lines and word-wrapping for the text can be adjusted by moving the control handle on the right edge of each piece of bracket text.

**Editing a Terminal Block**

The Define Terminal Block dialog works much like a standard spreadsheet. You can use the UP and DOWN arrow keys to navigate through the rows and the TAB and SHIFT+TAB keys to move across the columns. The PAGE UP, PAGE DOWN, HOME and END keys, as well as the scroll bar, also allow you to quickly move to any row.

The current row is always shown highlighted in blue. The Edit menu on the Define Terminal Block dialog provides selections for inserting a row before or after the current row, and for deleting the current row. After one of these commands, you can repeat the insert or delete by selecting F4.

You can also change the size of the block by changing the number of rows in the NUMBER OF ROWS text field. Increasing the number of rows will add blank rows to the end of the block. Reducing the number of rows will delete the rows at the end.

You can change the configuration of the block, with the curved lines on the right and the wire tags and brackets on the left by simply flipping the shape on its vertical axis.
Fill Down

The EDIT menu also contains a selection to show the Fill Down dialog, which can be used to quickly lay out terminal blocks with repetitive configurations:

The Fill Down dialog allows you to automatically fill in the specified number of rows following the currently selected row using the information in the current row. For example, if row 3 is highlighted, using Fill Down will fill in rows 4 and later using the information in row 3.

**Fill Down Using**

Select *Single Row* to copy the information from the current row into each of the subsequent rows. This is similar to the standard Fill Down in Excel.

Select *Use Group of n Rows* to fill down information in groups of 2 or more rows. The highlighted row will be the last row of the group. For example, if row 7 is highlighted and you select *Use Group of 3 Rows*, rows 5, 6 and 7 will form the group. The group is repeated as it is filled down, so in this example row 5 will be copied into row 8, row 6 into row 9 and row 7 into row 10. If necessary the pattern repeats, with row 5 copied into row 11, row 6 into row 12, row 7 into row 13, and so on.
**Fill Down Until**
Select *Bottom of Table* to copy the row or group into all the rows that follow the highlighted row. To copy the row or group a specific number of times, fill in the *Number of Rows/Groups* field. To fill until a specific row number, fill in the *Stop at Row* field.

**Fill Line Type/Show on BOM/Part Number/Wire Tag Type/Bracket Type**
Select the various checkboxes to indicate which of the fields should be copied. If a checkbox is turned off, the value of that field in the rows being copied into will not be changed.

**Fill Part Label/Wire Tag Label/Bracket Label**
When filling the various text labels, you can choose to fill with the *Same Value*, or to create a *Linear Series* from a numeric type of label. A numeric label can begin with non-numeric characters, but must end with a number. Any leading zeros in the numeric portion will be persevered.

For example, if the Part Label in the highlighted row is “ABC07”, filling it down using a Linear Series will create subsequent labels of “ABC08”, “ABC09”, “ABC10”, etc.

You can also specify the amount to increase each label as *Step Value*, and a value at which to stop with *Stop Value*.

**Panel Version**
The Terminal Blocks stencil also contains a Panel Version of the terminal block, which is linked to an existing terminal block to automatically generate its size and shape. After dragging the shape onto your drawing, select *Panel Device Properties*:

![Terminal Block (Panel Version) dialog]

The Terminal Block list box will contain the Bill of Material tags for all the terminal blocks on each page of the drawing. Select OK and the shape will reconfigure itself to match the specified block:
After they are linked, any changes in the terminal block will automatically be reflected in the panel version. If you change the Bill of Materials tag of the terminal block, however, the link will be broken. It can be restored by again selecting PANEL DEVICE PROPERTIES and selecting the updated tag.

Adding Custom Terminal Parts

Each terminal part in the database is represented by two shapes in the Terminal Blocks stencil, one for the schematic version and the other (drawn to 1/5 scale) for the panel version. Additional parts added to the database can be added to the shape by creating these two graphical representations and following a few additional steps. A second stencil, Terminal Blocks Extra.vss, has been provided for these custom shapes.

When you update a terminal block, it first searches for the part shapes in the Terminal Blocks stencil. If the corresponding shape is not found, the Terminal Blocks Extra stencil will be opened and searched. If the part is still not found, a blank spot will be left on the terminal block.

To add a custom part, follow these steps:

1. Copy the shapes for the two versions of an existing part from the Terminal Blocks stencil to the Terminal Blocks Extra stencil.

2. Edit the masters to change the graphical representations accordingly. In the schematic version, remember to account for the position of the part label text. In the panel version, be sure to preserve the 1/5 scale.

3. View the shape sheet for the parts. You will find two User defined cells, TBShapeType and TBShapeID.

4. The TBShapeType field should remain set to “PartTemplate” or “PanelTemplate”, according to which version of the part it represents.

5. The TBShapeID field should be changed to an eight character Item Code for the part. Multiple database parts that share a graphical representation (e.g., differ only in color) can use the same item code.
In the parts database, specify the following values when you add the parts (refer to the later chapter on the Database Manager for more information):

- **T5** Set to the value “DS2000TB”

- **T6** For DIN Rail parts to be displayed in the Terminal Block properties dialog, specify a value of ‘1’. For terminal block parts to be displayed in the Part Type drop-down list box in the Edit Terminal Block spreadsheet, specify a value of ‘2’.

- **T7** For DIN Rail parts (where Term6 is ‘1’), enter the width of the rail in inches. For terminal block parts (where Term6 is ‘2’), enter the Item Code as specified in the User.TBShapeID field of the corresponding shapes.
13. Wire Tags

The Wire Tag shape can be used to quickly and easily drop wiring and cabling information onto the drawing for use in the Bill of Material. There are a number of reports available through the Report Engine to then generate reports based on these wire tag shapes.

What is the Wire Tag?

The Wire Tag stencil contains a single shape named Wire Tag. This shape can be dropped onto the drawing, and represents any number of different parts. A Wire Tag can be associated with a Controller on the same drawing, or you can manually enter the information. The Bill of Material and the Wire Tag reports will see the Wire Tag shape on a drawing and generate the appropriate parts. The Wire Tag shape is not intended to show wiring layouts or diagram’s for the installing technician, but rather to ensure that wires and cables are included in back-end reporting for estimation and ordering.

The Wire Tag Shape

![Wire Tag Shape Image]

The Wire Tag shape is a simple diamond with room for a single digit tag. It also has a note associated with it.
Wire Tags

To associate part numbers with the Wire Tag, double-click the shape or right-click it and select SET PROPERTIES. This brings up the Wire Tag Editor form:

The Wire Tag Editor is broken into two sections. The top half of the window has basic Designer Suite shape information, such as BOM Tag, Show On BOM, Vendor, Manufacturer, and Not Typical. These properties will apply to each part included in the Wire Tag. You can also edit the note shown next to the tag on the drawing.

The lower half of the window shows one row for each wire associated with the Wire Tag. Each row has six pieces of information associated with it. This information is shown on the Wire Tag reports, or used in the Bill of Material. If the Wire Tag is associated with a controller, the Point drop-down lists all of the points that type of controller has. The Part Number drop-down lists all of the Wire parts in the database, and is automatically filtered by the Type and Color drop-down lists as you change those values. Footage is displayed on the Wire Tag reports, and used as the Quantity for the Bill of Material.

Rows may be added manually by clicking the black ADD ARROW button the upper left-hand corner of the section and deleted manually by clicking the red DELETE ARROW button next to each individual row.
Rows are added automatically when you associates a Wire Tag with a controller. The Controller drop-down lists all of the devices found on the same page as the Wire Tag shape. When a controller is chosen from the pull-down, the Wire Tag shape creates one row for each point on the controller that is connected.

The Point field is automatically filled in for each row, and the Tag is defaulted to Controller Name:Point Name, though that can be changed. Many controller types also have default part numbers in the database for their points. These defaults are brought in if they are found.

**Wire Tag Reports**

There are four Wire Tag reports available in the Reporting Engine. These reports search through the selected drawings and generate a listing of all of the wire tag shapes found on the drawings. Refer to the later chapter on the Reporting Engine for more information.

**System Tag Report (Wire Tags - Grouped by System.xls)**

This report generates one sheet in Excel for each System in the project that contains wires. Each individual wire with all of its information is shown. There is no combining of wires in this report.
Controller Tag Report (Wire Tags - Grouped by Controller.xls)
This report generates one sheet for each Controller in the project that has an associated Wire Tag shape. Every point on the controller is shown, regardless of whether it is connected to anything or has any wiring associated with that point. Any Wire Tag shapes with Custom in the Controller field are displayed on a separate sheet named Custom. Again, there is no combining of wires in this report.

Total Tag Reports (Wire Tags – Total [with System].xls)
The total reports tally up all of the wiring information for the entire project, adding the footages together whenever the part number is the same. The System version of this report breaks down the report by system, creating an worksheet for each system, while the Total version creates one sheet with all of the wiring totaled together.

Adding Wire Tag Parts to the Parts Database
The Database Manager has advanced action types that can be used to update and add to the wire parts that the Wire Tags use. Refer to the Parts Database Manager chapter of the Setup and Administration Guide for more information.
14. Smart Charts

Smart Charts provide a way to add instance specific information to a controller that is part of a typical system, and the means to display, edit and report this information for commissioning reports. Smart Charts allow you to customize the fields that are contained in the chart, and those that are displayed in the drawing, and uses Microsoft Excel extensively to design and generate user-defined reports and data entry templates.

What Is A Smart Chart?

Designer allows you to create systems that occur multiple times in a project by defining the system name and telling Designer that the system is “Typical of 20”. This allows you to draw the shapes in the system once, while allowing Designer to properly compute Bill of Material reports and other information. In such systems, everything about each instance of each component should be identical.

With controller devices, however, it becomes necessary to define certain pieces of information that are distinct for each instance of the controller. For example, it is important that each instance have its own Bill of Material tag, as well as information to indicate which other controller devices they are connected to and from. Network addresses also need to be unique for each device.

Smart Charts resolve this problem by creating a spreadsheet of information that is unique for each instance of the controller. You create a Smart Chart by specifying the “master” controller in the system that the Smart Chart represents, and based on the “Typical Of” value for the system, the Smart Chart creates a row for each instance. You then tell the Smart Chart which fields you want it to contain, and which of those fields you want displayed in the drawing. Next you edit the data in these fields, add custom fields, and create commissioning reports based on this data. Since Designer sees each row as if it were a separate device, all other functionality behaves properly.

Creating a Smart Chart

In this section we’ll walk through the steps used to create a Smart Chart from scratch. We’ll select our fields by hand and use the default spreadsheet views for editing and reporting our data. Later you will see that we can create and use our own custom Smart Chart Templates to automate the field selection and provide a much more robust view for data entry and reporting.

You start by creating a system that contains a controller device. In our example, we’ll show an MNL-100. You then drag a Smart Chart shape from the SmartChart stencil onto your drawing (it does not have to be near, or even on the same page, as the controller).
Initially the Smart Chart is represented by a wide, empty rectangle. If you right click on the chart you will see a number of menu items, although most of them are disabled. Before we can do anything else, we must first assign the Smart Chart to the controller. Select SMART CHART PROPERTIES from the menu to bring up the Properties dialog box.

![Smart Chart Properties dialog box](image)

First specify a name for the Smart Chart. This is not a Bill of Materials tag, since the Smart Chart itself is not a part. Next select the “master” device from the drop down list box. If the device is not on the list, click UPDATE DEVICE LIST and the drawing will be rescanned and the device added to the list.

After you’ve selected the master device, the name of its system and the Typical Of value will be filled in. You can’t change the system from here (you must do so in the master device’s property window, as explained later), but you can change the Typical Of value for the system by entering a different value. This change will affect the whole system, and is the same as changing the value by selecting SYSTEM NAMES→CHANGE TYPICAL OF VALUES FOR SYSTEMS from the DESIGN TOOLS menu.
Change the Typical Of value to 5 and Click Create. The Smart Chart will appear on the drawing.

<table>
<thead>
<tr>
<th>BOM Tag</th>
<th>From Device</th>
<th>Network Address</th>
<th>To Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>MNL-100</td>
<td>MNL-100</td>
<td>0:0:0:0:0</td>
<td>MNL-100</td>
</tr>
<tr>
<td>MNL-100</td>
<td>MNL-100</td>
<td>0:0:0:0:0</td>
<td>MNL-100</td>
</tr>
<tr>
<td>MNL-100</td>
<td>MNL-100</td>
<td>0:0:0:0:0</td>
<td>MNL-100</td>
</tr>
<tr>
<td>MNL-100</td>
<td>MNL-100</td>
<td>0:0:0:0:0</td>
<td>MNL-100</td>
</tr>
</tbody>
</table>

The Anatomy of a Smart Chart

Initially the Smart Chart contains four fields, or columns, all of which are displayed in the drawing. As you will see, you can add many other fields, including your own custom fields, to the chart as well. You can also select which of these fields are displayed in the drawing (the others are still stored in the chart, but displayed only when editing or generating reports), and change the text for the column headings.

You can select the Smart Chart as a whole by clicking on its top edge or on any heading in the header row. If you then move or drag the chart, the data rows will follow automatically. There are also numerous small square control handles in the chart that allow for resizing. Drag the handles on either side of the chart to change the width, and the columns will resize proportionally. Drag the handles on the top or bottom to change the height, and the height of the rows will adjust proportionally as well. Slide the handle between two column headings to change the width of only those columns.

Selecting the Fields in a Smart Chart

Right click on the Smart Chart and select EDIT FIELD LIST to see the list of fields that are contained in the Smart Chart.
The list box on the left shows all the fields in the Designer system, as well as any custom fields you have added (system fields are listed first). Each system field corresponds to a property of the master controller device as specified in its Properties window.

You will notice that each field is represented by a Field Code, shown on the left side of the list box, which cannot be changed. The text on the right is its description, which can be modified.

The list box on the right shows all of the fields that are contained in the Smart Chart. When a field is added to the Smart Chart, you will be able to enter distinct values for that field for each row (with some exceptions), and therefore for the controller that the row represents. You will also be able to display that field in any commissioning reports you generate from the chart.

To add fields to the chart, highlight one or more in the left list box (use SHIFT+CLICK and CTRL+CLICK for multiple selects) and click the right arrow. Select fields in the right list box and click the left arrow to remove them from the chart. If you select an individual field in the right list box, you can use the up and down arrows to change its position in the chart.

As you select fields in the right list box, the description is shown in the bottom text box, and is available for editing. Use this to change the default heading for a field.

You can use the ADD TO DICTIONARY… and EDIT… buttons to add custom fields to the user dictionary (and your chart), or to edit the default headings for an existing custom field.

If you select fields to add to the chart and click OK, you will get the following message:

Since the fields displayed in the drawing are only a subset of the fields in the chart, you have the option of automatically choosing them for display. If you don’t display them at this point, you can always choose to do so later. For our example, we will choose to add and display four additional fields:

<table>
<thead>
<tr>
<th>BOM Tag</th>
<th>Network Number</th>
<th>GCM Number</th>
<th>Local Device Address</th>
<th>Network Address</th>
<th>System</th>
<th>From Device</th>
<th>To Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>MNL-100</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.0.0.0:0:0</td>
<td>Default</td>
<td>MNL-100</td>
<td>MNL-100</td>
</tr>
<tr>
<td>MNL-100</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.0.0.0:0:0</td>
<td>Default</td>
<td>MNL-100</td>
<td>MNL-100</td>
</tr>
<tr>
<td>MNL-100</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.0.0.0:0:0</td>
<td>Default</td>
<td>MNL-100</td>
<td>MNL-100</td>
</tr>
<tr>
<td>MNL-100</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.0.0.0:0:0</td>
<td>Default</td>
<td>MNL-100</td>
<td>MNL-100</td>
</tr>
<tr>
<td>MNL-100</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.0.0.0:0:0</td>
<td>Default</td>
<td>MNL-100</td>
<td>MNL-100</td>
</tr>
</tbody>
</table>
**Selecting the Fields to Display in a Smart Chart**

Right click on the Smart Chart and select **EDIT DISPLAY LIST** to see the list of all the Smart Chart fields that are and are not displayed in the drawing. This dialog box is identical to the Select Fields dialog, except that now only the fields in this Smart Chart are shown, with those displayed in the drawing listed in the right list box and the remainder listed in the left list box. Again use the arrows to select which fields are displayed and not displayed, as well as the order in which they appear. Edit the text used for the column headings by selecting the field and editing the heading in the text box.

**Editing the Smart Chart Data**

The initial values in each row in the Smart Chart are the same as those in the master device. To change these values, right click the Smart Chart heading and select **EDIT CHART DATA** from the menu. This will open the Smart Chart for editing in Microsoft Excel.

![Excel sheet](image)

The data in the chart is now available for editing using a default standard spreadsheet format. Later you will see that we can apply a Template to the chart to provide a better form for data entry.
The editable fields are shown with red text and a gray background. All other elements of the spreadsheet are locked (i.e., you cannot add rows or adjust columns or formatting). You may also notice that some fields are not editable, such as the System field in the above example. These fields are read-only, and the rows always inherit their values from the master device. Adding them to the Smart Chart, however, makes them available for reporting.

<table>
<thead>
<tr>
<th>BOM Tag</th>
<th>Network Number</th>
<th>GCM Number</th>
<th>Local Device Address</th>
<th>Network Address</th>
<th>System</th>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-100-A</td>
<td>2</td>
<td>11</td>
<td>113</td>
<td>2.11:113:0:0</td>
<td>Default</td>
<td>C-XXX</td>
<td>M-100-B</td>
</tr>
<tr>
<td>M-100-B</td>
<td>3</td>
<td>13</td>
<td>127</td>
<td>2.13:127:0:0</td>
<td>Default</td>
<td>M-100-A</td>
<td>M-100-C</td>
</tr>
<tr>
<td>M-100-C</td>
<td>4</td>
<td>17</td>
<td>129</td>
<td>2.17:129:0:0</td>
<td>Default</td>
<td>M-100-B</td>
<td>M-100-D</td>
</tr>
<tr>
<td>M-100-D</td>
<td>5</td>
<td>19</td>
<td>131</td>
<td>2.19:131:0:0</td>
<td>Default</td>
<td>M-100-C</td>
<td>M-100-E</td>
</tr>
<tr>
<td>M-100-E</td>
<td>6</td>
<td>23</td>
<td>133</td>
<td>2.23:133:0:0</td>
<td>Default</td>
<td>M-100-D</td>
<td>C-XXX</td>
</tr>
</tbody>
</table>

After you have finished editing the data, close Excel either by clicking the Close icon or selecting RETURN TO DESIGNER from the FILE menu. You will be prompted to save your changes, and the Smart Chart will update itself in the drawing.

You may notice in this example that we did not need to edit the Network Address field itself, since this field is calculated (by combining the five separate fields, NetworkA-NetworkE),

**Generating a Smart Chart Report**

To generate a Smart Chart report, right click on the Smart Chart and Select RUN REPORT. You will be asked to select a report Template, which is an Excel file. If you don’t have a report Template created already, select DEFAULT.XLS.

The default report will look almost the same as the one presented for editing, except that now the whole sheet is editable and you are free to reformat it as you please.
Smart Chart Templates
So far we have created our Smart Chart manually – selecting the fields to include, those to display, and relying on the mostly unformatted default spreadsheets for editing the data and viewing our reports. The real power of the Smart Chart is unleashed when you apply your own custom view of the Smart Chart data in a specially coded Excel worksheet we’ll refer to as a Template (not to be confused with an Excel Template).

Creating a Smart Chart Template
As an example, let’s create a simple commissioning report to match the fields we’ve used so far: Bill of Material Tag, Network Address, and the To and From Devices. We’ll also add custom fields to indicate the room which the device controls.

Start by launching Excel and building the report, formatting the rows, columns and cells any way you’d like. You can even include graphics and formulas in the cells.

Here we have prepared the basis for our template. We’ve added heading information, including a formula to show today’s date, we’ve adjusted the font, format, and alignment of the data in the cell, including borders, and we’ve added columns for our custom Room field and a check box for the engineer to confirm the installation of each instance of the system. We’ve also included a single line of sample data to see the results of the formatting.

Save the report and close Excel.
Inserting Smart Chart Fields Using the Template Editor

Right click on the Smart Chart and select REPORT/TEMPLATE EDITOR:

Click on the EDIT REPORT TEMPLATE button and select the Excel file you just created. The file will be reopened in Excel.

We need to remove the sample data in the row and replace them with the field codes from the Smart Chart. Start by deleting the data in the cells (except the checkbox). Do not delete the entire row, as you will lose the formatting associated with the cells.

Now if you right click on a cell, you will notice a new menu item called INSERT DESIGNER SUITE FIELD CODE.
Select the empty box under System, right click, and select this menu item. You will see the Insert Designer Suite Field dialog box.

Here you can select any of the Designer system fields, or one of the custom fields you have created (the fields are listed alphabetically in two groups, with the system fields listed first). To insert a field code into the template, select the field and click **Insert**, or simply double-click the field in the list box. If you want to create a custom field and add it to your dictionary, enter the field code and a description in the text boxes on the bottom of the dialog box and click **Add**. To delete a custom field, select it and click **Delete**.

For our example, we’ll select the System field and click **Insert**.
You will see that the field code “<System>” has been inserted into the cell. The angle brackets denote a field code in our template, and the field code matches those that are shown in the Smart Chart field list. We could also have bypassed the Insert dialog and typed in the field code by hand.

To speed things up, we can select the entire row of fields at once. Right click on the row number in the spreadsheet and select INSERT DESIGNER SUITE FIELDS from the menu. The editor will now walk us through each empty cell in the row to allow us to choose a field code. We’ll select “<BOMTag>” for the Device Name, and create a custom field for Room.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th>Network</th>
<th>ROM</th>
<th>Local Address</th>
<th>From</th>
<th>To</th>
<th>Confirmed</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;System&gt;</td>
<td>&lt;BOMTag&gt;</td>
<td>Room</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Finally, we’ll insert fields for <NetworkA>, <NetworkB>, <NetworkC>, <FromDevice> and <ToDevice>.

While we can enter these field codes by hand, there is an extra reason to use the Insert dialog. Erase the field codes and again right click the row number and select INSERT DESIGNER SUITE FIELDS from the menu. This time as you go through the fields you should notice that the correct field is automatically selected for you in the list box. You need only click the INSERT button for each one. The Template Editor has learned from your column headings what the field should probably be, so the next time you create a
similar report with some or all of the same headings, it will remember which field probably belongs in the column.

Save the workbook (you will need to provide a file name, since the sheet we selected was reopened in a different workbook as read-only). You should keep your Smart Chart templates in the \Reports\Smart Chart sub-directory of your main Designer Suite directory.

**Running a Custom Report**
Now that we created a new Template, let’s use it to report the data in our sample Smart Chart. Right click on the Smart Chart, select Run Report, and select our new report template.

![Microsoft Excel - Commissioning Report](image)

This is a big improvement from the default unformatted version. You will notice, however, that our new Room field displays an error code. That’s because the field is not (yet) part of our Smart Chart.

**Assigning a Template to a Smart Chart**
Once we have created a Template, we can assign it to the Smart Chart by right-clicking the Smart Chart and selecting Assign Template from the menu. You will be prompted for the name of the Excel file.
When we assign our new Template to the existing chart, we will get the following messages:

Assigning a Template to a Smart Chart accomplishes three things. First, it tells the Smart Chart which Template to use when we edit the data in the chart. Second, it indicates which Report will be the default when we select RUN REPORT (although we can run any report at any time). Third, and most importantly, it automatically redefines which fields are and are not in the Smart Chart.

The field being removed is the <NetworkAddress>. The field being added is <Room>. For our example we’ll change the Smart Chart to match the Template, so we’ll Yes to both questions. The Smart Chart in the drawing will now look like this:

<table>
<thead>
<tr>
<th>System</th>
<th>Device Name</th>
<th>Room</th>
<th>Network</th>
<th>GCM</th>
<th>Local Address</th>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>M-100-A</td>
<td>2</td>
<td>11</td>
<td>113</td>
<td>C-XXX</td>
<td>M-100-B</td>
<td></td>
</tr>
<tr>
<td>Default</td>
<td>M-100-B</td>
<td>3</td>
<td>13</td>
<td>127</td>
<td>M-100-A</td>
<td>M-100-C</td>
<td></td>
</tr>
<tr>
<td>Default</td>
<td>M-100-C</td>
<td>5</td>
<td>17</td>
<td>129</td>
<td>M-100-B</td>
<td>M-100-D</td>
<td></td>
</tr>
<tr>
<td>Default</td>
<td>M-100-D</td>
<td>7</td>
<td>19</td>
<td>131</td>
<td>M-100-C</td>
<td>M-100-E</td>
<td></td>
</tr>
<tr>
<td>Default</td>
<td>M-100-E</td>
<td>9</td>
<td>23</td>
<td>133</td>
<td>M-100-D</td>
<td>C-XXX</td>
<td></td>
</tr>
</tbody>
</table>

Now if we select EDIT CHART DATA, we can fill in values for the Room field:
Templates are the easiest way to build a Smart Chart from scratch. Now that we have this Template, we could rebuild the Smart Chart by simply dropping the Smart Chart shape from the stencil (which creates it with the four default fields) and then assigning the Template (which removes the Network Address field and adds in the other five).

If at any time you want to change the Template back to the default view, which simply creates a blank spreadsheet with each column, choose the DEFAULT.XLS file when you select ASSIGN TEMPLATE from the menu.

The User Dictionary
As you create custom fields in your Smart Charts, they are automatically added to the User Dictionary database on your computer. This file is DSUserDictionary.mdb, and is stored in the DB subdirectory of your Designer system. If at any time you wish to transfer or merge this directory from another computer, copy the database file from the other computer to another location on your machine (don’t overwrite your own dictionary file), select REPORT/TEMPLATE EDITOR from your Smart Chart’s menu and click the IMPORT USER DICTIONARY button. You will be prompted for the location of the database file from the other machine, and given the option to overwrite your current directory or merge the entries.

Modifying the Master Device and System
As discussed, each row of the Smart Chart actually represents a device in your drawing. When you create the chart, many of the basic properties of the device (i.e., BOM Tag, Part Number, Description, Manufacturer, I/O points) are automatically copied from the device into these rows. Some of the properties can then be changed for each row (i.e., BOM Tag), and some cannot (i.e., Part information, System, Trade and I/O Points).
To change the properties of the Master device, you should right click on the Smart Chart and select **EDIT MASTER DEVICE PROPERTIES**. This will locate the device in the drawing and bring up its Properties window.

If you make changes to the properties of the master device, only the fields that cannot be modified in the Smart Chart (i.e., Part information, System, Trade and I/O Points) will be copied back into the rows. Any other fields, such as BOM Tag, that are modifiable in the Smart Chart, will not have their custom values overridden. If new rows are added to the chart they will however, inherit their initial values from these new properties.

Consider the following sample Smart Chart:

<table>
<thead>
<tr>
<th>BOM Tag</th>
<th>Part Number</th>
<th>Installing Trade</th>
<th>GCM Number</th>
<th>From Device</th>
<th>To Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-1</td>
<td>MNL-10RF2</td>
<td>Electrical</td>
<td>11</td>
<td>C-X</td>
<td>M-2</td>
</tr>
<tr>
<td>M-2</td>
<td>MNL-10RF2</td>
<td>Electrical</td>
<td>12</td>
<td>M-1</td>
<td>M-3</td>
</tr>
<tr>
<td>M-3</td>
<td>MNL-10RF2</td>
<td>Electrical</td>
<td>13</td>
<td>M-2</td>
<td>M-4</td>
</tr>
<tr>
<td>M-4</td>
<td>MNL-10RF2</td>
<td>Electrical</td>
<td>14</td>
<td>M-3</td>
<td>M-5</td>
</tr>
<tr>
<td>M-5</td>
<td>MNL-10RF2</td>
<td>Electrical</td>
<td>15</td>
<td>M-4</td>
<td>C-X</td>
</tr>
</tbody>
</table>

If we edit the properties of the master device, changing the Part Number, Installing Trade, and BOM Tag, the chart will update to the following:

<table>
<thead>
<tr>
<th>BOM Tag</th>
<th>Part Number</th>
<th>Installing Trade</th>
<th>GCM Number</th>
<th>From Device</th>
<th>To Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-1</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>11</td>
<td>C-X</td>
<td>M-2</td>
</tr>
<tr>
<td>M-2</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>12</td>
<td>M-1</td>
<td>M-3</td>
</tr>
<tr>
<td>M-3</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>13</td>
<td>M-2</td>
<td>M-4</td>
</tr>
<tr>
<td>M-4</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>14</td>
<td>M-3</td>
<td>M-5</td>
</tr>
<tr>
<td>M-5</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>15</td>
<td>M-4</td>
<td>C-X</td>
</tr>
</tbody>
</table>

Although the read-only properties have been changed, the modifiable fields have not. Now if rows are added to the chart, the new rows will inherit all the current properties of the master:

<table>
<thead>
<tr>
<th>BOM Tag</th>
<th>Part Number</th>
<th>Installing Trade</th>
<th>GCM Number</th>
<th>From Device</th>
<th>To Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-1</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>11</td>
<td>C-X</td>
<td>M-2</td>
</tr>
<tr>
<td>M-2</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>12</td>
<td>M-1</td>
<td>M-3</td>
</tr>
<tr>
<td>M-3</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>13</td>
<td>M-2</td>
<td>M-4</td>
</tr>
<tr>
<td>M-4</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>14</td>
<td>M-3</td>
<td>M-5</td>
</tr>
<tr>
<td>M-5</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>15</td>
<td>M-4</td>
<td>C-X</td>
</tr>
<tr>
<td>MNL-100</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>0</td>
<td>MNL-100</td>
<td>MNL-100</td>
</tr>
<tr>
<td>MNL-100</td>
<td>MNL-10RS1</td>
<td>Panel</td>
<td>0</td>
<td>MNL-100</td>
<td>MNL-100</td>
</tr>
</tbody>
</table>

You should avoid editing the master device’s properties from its own menu, as the changes will not be automatically made in the Smart Chart. If you do change the master device’s properties this way, you should then select the **EDIT MASTER DEVICE PROPERTIES** from the Smart Chart and click OK to have the Smart Chart read the changes.

### Changing the Number of Rows in the Smart Chart

The number of rows in the Smart Chart should reflect the Typical Of value for the system of the master device. Therefore, the Smart Chart will generally synchronize itself to this value.
You can change the Typical Of value for the system in several places. If you are using a Smart Chart, the most convenient way is to select SMART CHART PROPERTIES from the Smart Chart’s menu.

![SmartChart Editor (v2.0)](image)

Changing the Typical Of value here affects the whole system. Therefore you will be prompted to add or delete rows from the Smart Chart.

If you change the Typical Of value for the system somewhere else, by selecting SYSTEM NAMES ➔ CHANGE TYPICAL OF VALUE FOR SYSTEMS from the DESIGN TOOLS menu or in another Smart Chart in the same system, the Smart Chart will not update automatically. To resynchronize the chart, simply select SMART CHART PROPERTIES from its menu. The Smart Chart will detect the change and prompt you to make the appropriate change, such as:

![Smart Chart](image)

Remember that if you decrease the size of a system and agree to delete the rows from the Smart Chart, the data in those rows will be permanently lost.
15. Smart Clones

One of the features that make Designer so powerful is the ability to create your own shapes in Visio and enable them to interact with Designer in the same way as any other Smart Shape. These custom shapes are known as Smart Clones.

For a complete demonstration of Smart Clones, download or view the Designer Suite 2005 – Part IV – Smart Clones video presentation available on our website.

Creating a Smart Clone

The first step in creating a Smart Clone is to draw the shape. You can use any of the Visio drawing features, which are too numerous to discuss here, but the first step is often creating a transparent rectangle.

- If it’s not displayed already, select the Drawing Toolbar to be displayed in Visio.
- Click on the rectangle shape and draw a rectangle
- Right-click on the shape and select FORMAT → FILL. Change the Transparency value to 100%.

To convert the rectangle into a Smart Clone, select SMART CLONE → SMART CLONE DESIGNER from the DESIGN TOOLS menu.
The Smart Clone Properties window will appear, but for the moment simply close it to view how the shape has changed:

You will notice that the standard floating labels have been added to the shape, including BOM Tag, Part Number and Description.

Double-click the shape, or right-click and select **Set Properties** from the menu and a standard Part Properties dialog will be shown.
If this Smart Clone represents a single part not found in the Parts Database, you can set the values for Part Number, Description, Vendor and Manufacturer directly in the Part Properties. The shape will then be ready to store in a stencil and reuse (see the later section on Storing Smart Clones in a Custom Stencil).

**Drawing Smart Clone Shapes**

There are a few items and suggestions to note about drawing your Smart Clones shapes:

- When creating the shapes, try to adhere to the “100/200” rule. This refers to the suggestion that, when drawing the shapes, make sure that the Visio zoom magnification level is set to 100% or 200%. This is how all Designer shapes were created, and in cases where terminal leads need to align between shapes, it will be much easier to do so if you do the same.

- When you create a Smart Clone, the shape is automatically wrapped up in a Visio Group Shape. The most important effect of this is that when you want to alter the geometry, you will need to “Open” the group by selecting it and choosing the Edit ➜ Open Smart Clone menu item in Visio. If you ungroup the shape, you will lose all the properties that make the shape a Smart Clone. You may want to refer to the Visio documentation for more information about grouping.

**Storing Smart Clones in Stencils**

Once you have created a Smart Clone shape, you can turn it into a master shape by storing it in a custom stencil. Simply create the new stencil and drag the shape from the drawing into the stencil.

The earlier chapter on Working with Stencils and Smart Shapes outlines a number of important issues regarding creating your own stencils and where to store them. Please read that section before creating your own Smart Clones and custom stencils.

**Smart Clone Part Properties**

Beyond the standard properties that are displayed to the user when they drop an instance of the Smart Clone on the drawing, the Smart Clone Designer allows you to add additional functionality, such as:

- Showing or Hiding the Accessories Tab
- Adding Terminal values on an separate entry tab
- Specifying which part number in the database apply to the shape
**Editing the Smart Clone Properties**

To view and edit all the Smart Clone Properties, select the Smart Clone and again select SMART CLONES→SMART CLONE DESIGNER from the DESIGN TOOLS menu (the same command used to create the Smart Clone). Click the SMART CLONE PROPERTIES button.

The Part Properties dialog will be shown again, though this time there will be two additional tabs: *Terminals* and *Smart Clone*. You can still set the default values on the *Part Information* and *Accessory* tabs.

The *Smart Clone* tab contains two sub-tabs. The first is *Smart Clone Properties*:

![Smart Clone Properties](image)

On this page you can hide the *Accessories* tab from the user, and can set a different internal shape name for your Smart Clone shape. You can also set the properties of the *Terminal* tab. Refer to the later section on Smart Clone Terminals.
**Part Number Filters**

The second sub-tab allows you to specify exactly which parts will be displayed as choices when the user clicks the PART LIST… button in the Part Properties dialog for your shape.

- If your shape represents a single part, fill in the Part Information tab and leave the NO PART NUMBER LOOKUP LIST radio button selected. The PART LIST button will be hidden from the user.
- To filter on fields from the Parts Database, set one or more of the filter values, such as Manufacturer ID or Manufacturer Part Number Filter.
- For the specifiable filter values, you can use the ? (match any single character) and * (match zero or more of any character) wildcard symbols.
- If you specify more than one filter, only parts that match all the filters will be included in the part list.
- The Part Lookup Code is a custom field you can import with your own parts using the Database Manager. Its sole purpose is to allow you to create codes that you can use in this filter dialog.
- The DS 2002 Compatibility String is a coded value used in older Designer Smart Shapes, and is generally added to custom parts added through the Parts Database Manager to make them available in those older shapes.
• To create even more sophisticated filter queries, set the values in filter fields, select the SQL Query radio button, and click the CREATE button. The corresponding SQL query will be displayed and can then be edited.

While you’re editing the filters, you can switch back and forth to the Part Information page and click the PART LIST button to test your filters. For example, enter “C*” into the Manufacturer Part Number filter and go back and click PART LIST. The list will be reduced from the 14,000 parts to less than 200 that begin with ‘C’.

**Smart Clone Terminals**

Designer Smart Shapes can refer to a set of custom properties referred to as *Terminals* (since they are most often used to store the terminal labels or color names used in advanced shapes such as actuators). These values correspond to values in the Parts Database, and are often loaded from the Parts Database when a part is selected. You can actually use these values for any purpose.

**Configuring the Terminals Tab**

Select the Smart Clone and select SMART CLONES ➔ SMART CLONE DESIGNER from the DESIGN TOOLS menu. Click the SMART CLONE PROPERTIES button to bring up the Smart Clone Properties dialog. The *Smart Clone Properties* sub-tab contains a group of controls to configure the Terminals.

*Smart Clone Properties* dialog box

• To show the Terminal tab to the user, check the SHOW TERMINAL TAB checkbox.
• Specify the NUMBER OF TERMINALS to use.
• To rename the tab from its default name of “Terminals”, specify a different **Terminals Tab Name**.

• To tell the Smart Clone to load the Terminal values from the Parts Database when the user selects a Part Number, check the corresponding check box.

As an example, set the **Number of Terminals** to 2, check the **Show Terminals Tab** checkbox and set the **Terminals Tab Name** to “My Terminals”. Next, click on the **Terminals** tab.

![Terminals Tab](image)

• Check the **Show?** checkbox for each terminal to enable the caption editing.

• To change the caption that will be shown when the user views the Terminal page, change the default “Terminal N” text.

• To specify a default value, enter it in the value box.

To continue the example, change the caption for Terminal 1 to “Baud Rate” and the caption for Terminal 2 to “Power Source”. Then specify a default value in Terminal 1 for “56K”.

Close the Smart Clone Properties dialog to return to Visio. Then double-click the shape to view the Part Properties.

![Part Properties](image)

**Showing Terminal Values in the Shape**

You can use the Terminal values, either loaded from the database or entered by the user, as text on your shape. Refer to the next section on the Smart Clone Designer.
Using the Smart Clone Designer

Although you can edit your Smart Clone shapes in Visio without any interaction from Designer, it is useful to edit it by using the Smart Clone Designer.

- Select the Smart Clone and select SMARTCLONE→SMART CLONE DESIGNER from the DESIGN TOOLS menu.
- Click on the OPEN SHAPE button. The Smart Clone shape’s group will be open for editing. The shape will appear alone with a different background. The Smart Clone Designer window will remain on top.

You can now begin adding sub-shapes, such as other rectangles, circles or text within the group. When you’re done, close the Smart Clone Designer or the Visio group editing window.

Label and Terminal Components

A component is a sub-shape that is controlled by Designer. It allows you to create text and terminal labels that add features similar to the Designer Smart Shapes.

Click on the TERMINAL button in the ADD COMPONENT group. A sub-shape with the text “Terminal” and a line extending out will appear in the center of the shape. Drag it to the edge so the left side of the line is aligned with the right side of the shape.
A LABEL component is similar, but has only text and no line.

**Component Properties**
The components can be configured in a number of ways. To change the properties of a component, click on it in the group editing window. The COMPONENT PROPERTIES region of the Smart Clone Properties window will be enabled.

- You can explicitly name the component for internal use in Visio Shape Sheets by specifying the NAME.
- The **Terminal** component allows the user to resize the line by grabbing the yellow control handle at the end. The **Label** component allows the user to move the label in the same way (as with built-in labels such as the Part Number and BOM Tag).
To prevent the user from making these changes, uncheck the SHOW CONTROL HANDLE TO USER checkbox.

**Component Text Values**

There are a number of ways to control the text value portion of the component.

- To use a fixed text value, select CONSTANT and enter the value.
- To tie the text to one of the Terminal values (loaded from the Parts Database or edited by the user), select TERMINAL NUMBER and choose the number of the terminal value.
- To change the alignment of the text relative to its position, set the TEXT ALIGNMENT value. For Label components where the text is not constant, the alignment determines the direction in which the text expands. For Terminal components, the alignment controls how the text is aligned with the line.
- To show a rectangle around the text, select the SHOW BOUNDING RECTANGLE AROUND THE TEXT checkbox.

To specify a more complex text formula, select the FORMULA radio button and enter the formula expression. These correspond to the formulas used in Visio’s Shape Sheets, and include the following:

- References to any Shape Sheet cell, such as *Width*
- References to Smart Shape properties, such as `{SC}!Prop.P12`, which is the Part Number.
- References to the Terminal values, such as `{SC}!User.Term1`
- Text constants prepended or appended to other values with the `&` operator.

For example, the following formula shows the value of Terminal 1 along with the Part Number and a prefix:

"Baud Rate: " & {SC}!User.Term1 & " (" & {SC}!Prop.P12 & ")"
The use of the “{SC}” notation is shorthand for a Visio reference to the Smart Clone shape itself.

The green Valid light will indicate if the formula is valid as you type it.

When designing the shape, it may be helpful to temporarily override the calculated text value, especially if the terminal value or formula results in an empty string (and therefore no visible text). In this case, select the PLACEHOLDERS radio button under SHOW TEXT AS. For normal operation, select RESULTS FOR FORMULA.

**Selectively Showing and Hiding a Component**

The SHOW/HIDE COMPONENT fields in the Component Properties allow you to control when the component is shown or when it is completely hidden. Choices include:

- Always shown
- Hidden if the value of a terminal field is empty
- Hidden if the value of a custom formula is true. The previous section describes how to compose valid formulas. In this case, the formula should evaluate to a boolean or numeric value.

For example, to program a component to hide if the shape is resized smaller than two inches, select the HIDE IF FORMULA IS TRUE radio button and enter the following formula:

```plaintext
{SC}!Width < 2
```

While designing the shape, it may be helpful to temporarily override the Show/Hide value, especially if the default is for the component to be hidden. In this case, select the SHOW ALL radio button under VIEW COMPONENTS. For normal operation, select BASED ON FORMULA.
**Flipping a Terminal Component**
To use a Terminal component shape on the opposite side of the Smart Clone shape, flip it horizontally from the Visio Action toolbar or select Shape → Rotate or Flip → Flip Horizontal.

**Changing the Component Font**
To change the font (and other text properties), right click on the component and select Format → Text.
16. The Page Wizard

The Page Wizard is a tool for managing the information on all the Title Blocks in your drawing files. It eliminates a large amount of manual work when there are global changes to the project information in the Title Blocks, such as project names and page numbers.

For more information on Title Blocks, refer to the earlier chapter on Page Add Ins.

To update the Revision Notes section of multiple Title Blocks, use the Revision Notes tool described in a later chapter.

Running the Page Wizard

To start the Page Wizard:

- Select a Designer-specific folder in the Project View (i.e., the root Designer node or a Systems or Schedules folder); then
  - Go to the Designer Tools tab and click the PAGE WIZARD Button; or
  - Right-click on the folder and select TOOLS ➔ DESIGNER ➔ PAGE WIZARD

If there are any unscanned files (those added to the project but not edited from within the project), they will be scanned.

You will then be asked which files contain the title blocks with which you want to work. Only Systems and Schedules folders will be shown. Check any folder node to automatically select the folders and files beneath it.
The Page Wizard screen has two main regions:

- The right side shows a list of all the pages in the selected drawing files.
  - Only pages with a Title Block shape are included. All other pages are ignored.
  - You can re-sort the list by clicking on any column heading.
  - The Page Name field refers to the name of the page’s tab in Visio.
  - The Page System refers to the System Name field in the title block. It is unrelated to the System Names assigned to parts in the drawing.
  - You can change the Page Name and Page System names by clicking in a cell and entering a new value.

- The left side of the Page Wizard window is used to change the other Project Information fields in the Title Block, as described later in this chapter.

### Renumbering the Pages

The Page Numbers are used by the Print Manager to print the pages out in the proper order, regardless of the order in which they appear in the Visio file or even which file they are stored in.

- To change a page number, click in the cell and change the value.

If you leave the **Automatically renumber pages when inserting duplicate page number** checkbox selected, entering the number of a page that already exists will cause the Page Wizard to renumber the existing page with the same number and automatically increment any other numbered pages to keep them in order.
If there are holes in the page range, say from removing a page, you can renumber all the pages to remove the holes by clicking the **RENUMBER PAGES** button. You will be asked to specify the starting page number.

![Page Wizard dialog box](image)

The pages will be renumbered based on their current *Page Number* order (regardless of how the pages are sorted in the list). If there are multiple pages with the same number, they will be numbered consecutively (but arbitrarily).

**Updating Project Information Fields**

The right side of the Page Wizard contains entry fields for the rest of the Project Information values in the Title Block, defaulted to the current Project Properties values. You can force a new value for one or more fields to be inserted into all the Title Block.

- Check the **UPDATE TITLE BLOCKS WITH** checkbox to enable the fields.
- Check the box next to the fields you wish to update
- Enter the new value in the text box field.

If the box next to a field is left unchecked, that field is ignored during the update and the value for that field in each Title Block is left at its current value.

To clear the value for a field in every title block, check the box next to the field and leave the entry field blank.

- When you prepare to print the documents, you will likely want to update the Page Count (e.g. Page 1 of [ ] field for each page.

**Updating the Drawing Files**

When you are done making changes, click the **UPDATE DRAWINGS…** button. The Page Wizard will then load each Visio file that has changes, make the updates and then save the file.
17. The Print Manager

The Print Manager is the easiest way to print the submittal drawing pages from multiple files. It allows you to select pages by file or by page number, and can output the pages in the correct Page Number order, regardless of their order within the Visio file, or whether sequential pages appear in different drawing files.

To start the Print Manager:

- Select a Designer-specific folder in the Project View (i.e., the root Designer node or a Systems or Schedules folder); then
  - Go to the Designer Tools tab and click the PRINT MANAGER Button; or
  - Right-click on the folder and select TOOLS→DESIGNER→PRINT MANAGER

If there are any unscanned files (those added to the project but not edited from within the project), they will be scanned.

**Note:** There are known issues in Visio 2002 that can cause the page size and number of copies to be wrong when printing through the Print Manager. These problems don’t seem to occur in Visio 2003 and later.

Using the Print Manager

The Print Manager shows all the drawing pages in the project, structured by the Project’s folder structure. The files are shown within their folder, and the pages are shown within their files.
Only files in scannable folders will be shown, and only folders with files will be shown.

You can select a single page, an entire drawing file or an entire folder. Selecting a node automatically selects all the nodes below.

The Page Numbers shown indicate the page number from the page’s Title Block.

You can select a range of Page Numbers by clicking the SELECT PAGE RANGE button.

Printing the Pages

To print the selected pages, click the PRINT SELECTED PAGES button. The pages will be printed to the selected printer.

The Print Order

The default PRINT ORDER is BY PAGE NUMBER. This causes the pages to be printed individually, in order of their Title Block page number.
To ignore the Page Numbers and print the selected files and pages in the order shown in the tree, select the **By File** radio button.

If you have multiple sets of separately numbered pages (e.g., a pre-submittal version and an as-built version) that you want to print at the same time without the pages getting mixed together (e.g., both Page 1’s would be printed together, which would be incorrect), select **By Folder, Then Page Number**.

**Printing to a PDF File**

If you are using software that allows you to print to a PDF Printer Driver (such as Adobe Acrobat or CutePDF), you can select that printer driver from the printer list. As each print command is issued to Visio behind the scenes by the Print Manager, you will be prompted for the file name to use to save the PDF file.

One side effect of the default **By Page Number** option for *Print Order* is that the Print Manager prints each page individually, even if multiple pages in the same file appear in order. This will cause the PDF Printer driver to store each page in a separate PDF file, and to prompt you each time. To counteract this effect, use the **By File** option instead and select entire files. The Print Manager will then issue a single print command for each file.

- A separate PDF file will be created for each drawing file. There is no way to merge the output of multiple drawing files into a single PDF file from within Designer. You will need to use a third-party PDF management tool.
- The pages will appear in the order in which they are shown in the tree, which corresponds to the order in which they appear in the Visio file. If this order is not the one that you want, you can reorder them within Visio.
- If you select less than all the pages in a drawing file, the Print Manager will need to revert to the **By Page Number** process and print the pages individually.
18. Revision Notes

The Revision Notes tool can be used to update the values in the Revision Notes section of the Title Block shapes on multiple pages in multiple drawing files.

The Revision Notes Section of the Title Block
The Title Block shape has room for up to five revision notes with a date. You can edit them on an individual title block by double-clicking the title block or right-clicking the title block and selecting Edit Title Block.

The Revision Notes Tool
To update multiple Title Blocks with the same revision note:

- Select a Designer-specific folder in the Project View (i.e., the root Designer node or a Systems or Schedules folder); then
  - Go to the Designer Tools tab and click the Revision Notes Button; or
  - Right-click on the folder and select Tools ➔ Designer ➔ Revision Notes
After selecting the files you want to work with, the Add Revision Note dialog will be shown.

- To add a note to each title block, enter the note and date.

By default, the note will be added in the first available slot in each title block. If there are already five notes in a title block, you will be given the option to replace the last revision with the new one:

You can also choose to erase all the revisions in each title block and add the new note as the first and only one. This is useful when doing As Built drawings and you want to remove the revisions added during the earlier phases and mark everything as “Record Drawings”.

Revision Notes
Removing Revision Bubbles

One other option you have that is useful when creating Record Drawings for As-Builts is to remove the Revision Bubble shapes that may have been added during earlier phases.

- If you are only removing the Revision Bubble shapes and not adding a Revision Note, you should select the DO NOT CHANGE REVISION NOTES option under POSITION OF REVISION NOTE.
19. Table of Contents

The Table of Contents tool will create and update a Table of Contents page for your project. The Table of Contents will automatically include page and system names from the title blocks of your drawings, and can also include additional page references, such as tables, schedules and indexes. You can also customize the format of the Table of Contents in a number of ways.

Creating a Table of Contents

A Table of Contents is a specific type of Designer drawing. You create one in a Systems folder in a similar way:

- Right-click on a Systems folder (or right-click in the empty area of its Files tab) and select NEW→TABLE OF CONTENTS.

The Table of Contents drawing file is created as a copy of the Table of Contents template, which you can customize and then distribute to other users. Refer to the later sections of this chapter and the earlier chapter on Customizing Designer.

Opening and Editing a Table of Contents

You open the Table of Contents, as you would any file in Smartware Studio, by double-clicking it in the file list. When you do you will be given an option on how to open it:

- Opening it in Visio alone is generally faster if you only want to view the file.

You will be shown a list of the drawing files in your system folders. Select the files or folders containing the pages you wish to include in the table.

- Only pages containing a Title Block will be recognized.
Two windows will be open when you work with the Table of Contents tool:

- An instance of Visio showing the generated drawing file
- The Table of Contents Wizard window.

**The Table of Contents Drawing File**

The Table of Contents is created as a Visio drawing page.

The page consists or a set of Project Properties fields, such as *Project Name*, *Address* and *Architect*, and the actual Table of Contents. Before you update it the first time, the Table of Contents appears as a note.

Even though the Table of Contents drawing file is opened in Visio, you generally update the information on this page using the Table of Contents dialog window. When you click **UPDATE** on that form, the changes will immediately be made to the Visio Table of Contents file for you to see.

You can customize the template file used when created a new Table of Contents. Refer to the section later in this chapter.
The Table of Contents Wizard Form

You can make most of the changes to the items listed in the Table of Contents in the Table of Contents Wizard.

- You can fill in or modify the PAGE HEADING INFORMATION, such as Project Name, Number and Address. These fields are generally copied from the Project Properties, but you can modify them here to change how they appear on the Table of Contents page. To change which heading fields appear on the Table of Contents page, refer to the section on Modifying the Table of Contents Template.

- You can select which pages are shown on the Table of Contents by checking or unchecking the box next to each page.

- Select a FORMAT STRING to specify how the items in the TOC are displayed. Refer to the section on Custom Format Strings for more information.

- Select the NUMBER OF COLUMNS to use when displaying items in the table.

- To modify the page numbers or page system names, use the Page Wizard.
When you are done, click UPDATE to regenerate the Table of Contents in the Visio drawing file.

You can continue to change the settings and click UPDATE again to see other variations. When you are done, click CLOSE to close the form and Visio.

**Adding Additional Items to the Table of Contents**

Additional items can be added before or after the pages in the page list by clicking on the ADD button next to the page list.
The items will appear with a different background color.

<table>
<thead>
<tr>
<th>Page List</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Page List" /></td>
</tr>
</tbody>
</table>

- These items can be modified and moved by clicking the Edit button, or moved by simply dragging them above or below each other.
- You cannot move custom items in between the actual numbered pages.
- To delete an item, click the Edit button and then click Delete on the Edit Form.

**Custom Format Strings**

The Format String list box allows you to choose how items are displayed in the table. Similar to custom headers and footers in Excel, they contain special codes to indicate the placement of the page number, page count, system name and tab characters.

- `&p` Page Number
- `&P` Page Count
- `&s` System Name
- `&t` Tab (move to next sub-column)

All other characters are displayed as is for each item. For example, if the format string were:

```
Page &p of &P&t&s
```

The items in the TOC would be formatted similar to:

<table>
<thead>
<tr>
<th>Page</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 of 20</td>
<td>AHU-1</td>
</tr>
<tr>
<td>2 of 20</td>
<td>RTU-1</td>
</tr>
</tbody>
</table>
You can choose one of the predefined format strings or type in your own.

- If an item does not have a Page Number specified, any tab-delimited section containing the “&p” code will be shown as blank for that item. With the above example, a custom item with no page number or a drawing page with no page number in the title block would be displayed without anything in the first sub-column. This is by design.

- The TOC will automatically adjust the tab stops appropriately to accommodate the number of sub-columns. Spacing between full columns is larger than that between sub-columns.

### Changing the Font Used in the Table of Contents

For the actual Table of Contents, you can change the font used in the table. When the table is updated, the font and size are automatically taken into account when setting the tab stops used to separate the columns of items as well as the sub-columns separated by tabs (&t) within the items themselves.

To change the font of the Table of Contents:

- In the Visio drawing file, right-click on the Table of Contents shape and select **Format TEXT**.
- Specify a different font and/or font size.
- In the Table of Contents Wizard form, click **Update** to redraw the table.

### Modifying the Table of Contents Template

You can create a customized version of the template to be used for all new Tables of Contents which can include your company logo and your preferences with regard to the location and fonts used for page heading information and the Table of Contents itself.

- Refer to the earlier chapter *Customizing Designer* for details on creating, selecting and distributing a customized template file.

When editing your template file in Visio, you can move or reformat the Page Heading fields using normal Visio features, as well as some custom features:

- To change their font, use the controls in the toolbar or right-click them and selecting the **Format TEXT** menu item.

- To further customize the Page Heading fields, double-click them or right-click and select **Modify Table of Contents Field**. You will then be able to select which Page Heading field the shape displays. You can also specify a Prefix string to be used in the display. For example, you may want the word “Engineer:” to appear before the actual Engineer’s name, but you don’t necessarily want the phrase “Project Name:” to appear before the name of the project.
• To create a new Page Heading field, simply copy and paste an existing one and then double-click it to map it to the appropriate field.
20. Valve Legends

When you create a valve schedule, you can specify for each valve the configuration of the piping. The Valve Legend tool is used to gather together the list of all the different piping details used in these schedules and generate a legend sheet that shows a picture of each one.

For more information on Valve Schedules and the piping detail codes, refer to the earlier chapter on Valve, Damper and Air Flow Schedules.

Creating a Valve Legend

To create a Valve Legend,

- Select a Systems folder in the Project View; then
  - Go to the Designer Tools tab and click the VALVE LEGEND Button; or
  - Right-click on the folder and select TOOLS>DESIGNER>VALVE LEGEND

- You will first be prompted with a list of the Valve Schedules in your project. Select one or more to include in the legend.
- You will be asked whether you want to include the System Names under each piping detail in the legend.
The Valve Legend page will then be generated and opened in Visio.

Each detail will appear only once, no matter how many times it is referenced in the Valve Schedules. If you requested, the System Names will appear beneath the detail diagrams.
Customizing the Valve Legend Template
You can create your own version of the template file used to create a Valve Legend. Refer to the earlier chapter on *Customizing Designer* for more information.
21. Reports

The Reports Tab is used to create a wide range of fully customizable reports using the data collected from the drawings and schedules in your project. Since it uses Excel for both creating the report templates and generating the reports, it is very easy to manipulate the reports it creates and to create your own reports with sophisticated features.

Generating Reports

To generate reports:

- Select a Designer-specific folder in the Project View (i.e., the root Designer node or a Systems or Schedules folder); then
  - Go to the Designer Tools tab and click the REPORTS Button; or
  - Right-click on the folder and select TOOLS ➔ DESIGNER ➔ REPORTS

If there are any unscanned files (those added to the project but not edited from within the project), they will be scanned.

- To run a report, select it in from the list and click the RUN SELECTED REPORTS button. The reports will be generated and opened up in Microsoft Excel.
• You can run your reports against the parts from all files in the projects, or select a set of files or systems. To select by files or systems, select the appropriate radio button and then click the SELECT FILES… or SELECT SYSTEMS… button to view the file or system tree.

• If you select multiple reports, they will be generated into a single Excel workbook with multiple worksheet tabs.

• The generated report files are automatically saved on the Files tab of the root Designer node in the Project View tree.

• Pricing and Description information about all parts is automatically updated from the Parts Database whenever you run a report.

• You can have the reports converted into a PDF file. Some additional configuration is required on each workstation. Go to TOOLS→OPTIONS and select the PDF Generator tab, and refer to the Setup and Administration Guide for full details.

• The Reporting Engine will remember your choice of SELECT FILES or SYSTEMS for the project the next time you start the Reporting Engine.

• There is a second tab, Reports (DS 2005), which contains the full list of Designer Suite 2005 reports for backward compatibility. Most of these reports will eventually be migrated to the main Reports tab.

Types of Reports
The reports included with Designer can be broken up into a few distinct categories.
Material Reports

The most common reports are used to generate a list of the parts in a project. These reports can be formatted as a Bill of Material or as a Vendor’s order form.

- The *Bill Of Material* provides a complete list of the material with all of its detail.

These reports are useful starting points for creating custom order forms for other vendors.

TAC iPortal Reports

The *TAC iPortal* system allows you to create, process and track your orders online through their web site. To make it easier to create these orders, you can export the data from your Designer projects into a spreadsheet format that can be uploaded directly into an *iPortal* Shopping Cart.

There are two versions of the report, one for regular parts (*TAC iPortal Import Sheet*) and other for Valves (*TAC iPortal Import Sheet (Valves)*).

To export your parts from Designer Suite 2005 and import them into iPortal:

- Follow the instructions and the start of this chapter to select the parts you want and run the *TAC iPortal Import Sheet* or *TAC iPortal Import Sheet (Valves)* report. The part list will be generated into an Excel spreadsheet suitable for importing into *iPortal*: 
When using the Valve version of the report, the Bill of Material tag for each valve will be shown in both the Metal Tag and Paper Tag columns. If you want to order tags for the valves, erase the tag name in the column you don’t want. If you don’t want to order tags, erase the tag name in both columns.

Save the file to any location on your hard drive or network.
• In the *iPortal* System, while working with a shopping cart, click on the **IMPORT FROM SPREADSHEET** button:

![](image)

• Follow the instructions provided by *iPortal*, which will direct you to browse to and upload the spreadsheet generated by Designer.

For more information on *TAC iPortal*, please consult the help pages on the *iPortal* website.

**Parts Reports**
Similar to Material Reports, these reports provide more technical information about the parts and where they were located within the project’s files.
The Part Index Report shows a list of parts and the page numbers on which they appear.

The Part Listing (Detailed Validation) report shows a list of the parts, including the name of the file they appear in and an indication of whether the part was found in the Parts Database.

- Parts that aren’t in the Parts Database may be obsolete, and will not have a price associated with them in a Material Report.
- If the part is in the database but obsolete, any known replacement part is listed.
**Controller and Commissioning Reports**

There are a number of reports that can be used to summarize device and point information for the purposes of doing commissioning and checkout procedures, and providing labels to put on the physical wire connecting the controllers.

The *Controller Summary* report provides a simple list of the controllers in the project, along with their addressing information.
The **Controller Checkout** report generates a workbook with a worksheet for each controller in the project listing all the points on the controller, along with the point type and check boxes, making them ideal as a commissioning checklist form.

![Controller Checkout Report Sample](image-url)
The *System Point List* report is similar to the checkout report, with one worksheet for each controller.

![Excel spreadsheet](image1.png)

The *Controller Wire Tags* report create a simple file that can be used as the source file for a mail merge.

![Excel spreadsheet](image2.png)
You can use this data file to create wire tag labels in Microsoft Word.

- Run the Controller Wire Tags report and save the resulting Excel file to a temporary location.
- Open the Controller Wire Tags Merge.doc file from the Reports\Designer Suite folder in your Application Data folder.
- Depending on the version of Microsoft Word, you will be prompted to locate or update the data file.

- Locate and select the Excel file to which you saved the data.
- The file will be opened in Word.
- If not visible already, make the Mail Merge toolbar visible.

- Click the Merge to New Document icon to create the labels.
The labels can be printed on Avery Standard 2160 Mailing Labels (1" x 2.63" each, 4 across x 20 down) or compatible.

**Software Reports**
The Software Detail and Software Summary reports list the Software File values specified in the controllers.

**Wire Tag Reports**
There are four Wire Tag reports which report on the information collected from the Wire Tag shapes.

- Wire Tags – Grouped by System
- Wire Tags – Grouped by Controller
- Wire Tags – Total
- Wire Tags – Total with System

Refer to the earlier chapter on Wire Tags for more information.

**Creating Custom Reports**
The Designer Reports are stored with your application data (C:\Documents and Settings\All Users\Application Data\Smartware Studio in Windows XP,
You can create your own reports, either as slight variations of existing reports or from other forms, such as another vendor’s order form. In either case, if you put the report template in the standard reports folder, the report will appear in the available report list automatically.

To create a customized version of a report:

- In Windows Explorer, copy the closest report to the one you want and rename it. Leave the new report in the same folder.

- Open your new template report and make your changes. Refer to the next section on Report Templates for more information.

Under no circumstances should you modify one of the Designer reports directly. Your changes will be overwritten the next time Smartware Studio is updated.

**Distributing Custom Reports**

Once created, you can put the custom reports on your server (in the Resources\Reports folders) to have them copied to all the workstations in your organization automatically.

**Report Templates**

A Report Template is an Excel worksheet with field codes added to indicate where data will be inserted when the report is run. It contains a detail section, which is generated once for each output record, and can contain header and footer sections above and below the detail. There are also facilities for section breaks, aggregate formulas such as totals, and XML-style data.
Field Codes

Field Codes are entered as placeholders in cells by enclosing them in angle brackets, such as “<PartNumber>” or “<Price>”. The fields that are available depend on the component generating the data for the report.

When the report is run the field code is removed and replaced with the value for that field. However, all formatting in the cell remains the same. This includes font, style (bold, italic, underline), size, color, and alignment, as well as numeric and date formats. When you design a report, you should put a sample value into the cell, format it appropriately, and then replace it with the field code.

Report Sections

A report will generally consist of three sections: a set of header rows, a single detail row, and a set of footer rows. When the report is run, the header section will appear once, while the detail row will be repeated for each record in the data set. The values for field codes that appear in the header are taken from the first output record.

If not specified explicitly with a Control Column, the detail row is assumed to be the last row in the sheet that contains a field code. All rows above it are assumed to be the header, and all rows below it are assumed to be the footer.
The Control Column
You can explicitly define the sections by including a Control Column. If cell A1 contains an <H> tag, the entire first column is assumed to contain section control information for the report, and will be removed when the report is generated. You can use the following tags:

- `<H>` Begin header section
- `<D>` Begin detail section
- `<F>` Begin footer section
- `<X>` Begin XML-style data section

After a section begins, it is assumed to continue until the next different tag or the end of the worksheet.

The <H> tag also accepts certain attributes, which appear after the H but before the closing angle bracket.

- `<H RepeatOnPage>` The entire header is repeated at the top of each page

Grouping
You can break up groups of records into multiple pages by using the following header tag attributes:

- `<H GroupField=fieldcode GroupOn=groupon>`

In the output report, each time the value of the `<fieldcode>` field changes between two records, a new worksheet tab is created with a separate output report. The value of `<fieldcode>` is used for the name of the worksheet on its tab.

Generally speaking, the output needs to be sorted on the `<fieldcode>` field to group on it.

- `groupon=Sheets` Each group goes on a separate worksheet page
- `groupon=SamePage` The detail and footer sections of each group repeat on the same page (the header is suppressed after the first time)

Adding Filters
You can have Excel’s AutoFilters added to your detail columns by including the following attribute in the detail tag:

- `<D Filter=Auto>`

This will allow you to filter the output rows based on different criteria in each column, using drop down list boxes added to the column headings.
**Using Formulas**

Use can use any formula that you would normally use in Excel and use cells containing the `<fieldcode>` fields as parameters. The only thing to realize is that since the cells contain text in the template, the result of the formula will often be an error until the report is run.

For example, in the report template in the Overview you can see that the detail section (row 21) contains `<Qty>` and `<Price>` fields in columns K and L. Column M contains the product of these, with a formula of “=K21*L21”. Since the text values “<Qty>” and “<Price>” can’t be converted to numbers, Excel returns a “#VALUE” error. However, when the report is run and the field codes are replaced with numbers, the formula will be recalculated and produce the extended price we were looking for.

**Aggregate Formulas**

To produce totals and other formulas based on the aggregate of multiple rows in the output report, use the following special notation around the cell reference in the formula:

\[
\text{AGG}(\text{cellref})
\]

When the report is run, the reference to the cell is expanded to include the range of cells for that column in all the output records.

For example, in the sample report shown in the Overview, cell M23 in the footer contains the formula “=SUM(AGG(M21))”. If the report is run with 10 records, they will end up occupying rows 21 to 30 in the output report. The phrase “AGG(M21)” in the formula will be expanded to “M21:M30”, and the resulting formula will be “=SUM(M21:M30)”, which will properly evaluate to the sum of the values in that column for each row.

It doesn’t matter whether the value in M21 was an Excel formula or a field code. Nor are you restricted to the SUM function, as any Excel function will work (e.g., “=AVG(AGG(M21))”, or even “=SUM(AGG(M21)) / COUNT(AGG(M21))”). The only restrictions are that the aggregate formula be in the footer section (which requires the use of the Control Column), and that the cell reference be a cell in the detail section.

If the detail section spans more than one row, the aggregate function will attempt to properly build the formula by creating a list of the appropriate cells. For example, if the detail section of a report template occupied rows 30 to 32, and the output report contained 5 records, a reference such as “=SUM(AGG(F30))” would be translated into “=SUM(F30,F33,F36,F39,F42)”, which would evaluate properly. In Excel, however, most functions are limited to 32 parameters, so if there are more than 32 records in the generated report, there is no choice but to translate the cell reference into the entire column (i.e., “=SUM(F30:F126)”). This will only be a problem if the detail section contains other numeric values in the same column of its other rows (i.e., cells F31
or F32). As long as those cells are blank or contain only text, the formula will still evaluate properly.

**Grand Totals**

By adding the `GrandTotal` attribute to the footer, the footer section is repeated one final time, with a `Sum()` function added for all fields that contained an AGG function in the footer.

`<F GrandTotal=true>`

**<X> Data Section**

The Report Template can also include an XML-style data section, which is used by certain Designer Suite components to indicate properties of the report, such as which fields to sort on, which fields to offer as filters, etc. If not expected by the component, this section will be ignored.
The data in this report would represent the following similar XML file:

```xml
<?xml version="1.0" ?>
<X Title="Commissioning Report" Author="Smartware Technologies, Inc." Version="1.3">
- <Filters>
  <Field FieldCode="Room" Operator="=" Sort="Ascending" />
  <Field FieldCode="BOMTag" Operator="<>" Sort="Descending" />
</Filters>
<SQL Select="#" FROM="tblData" OrderBy="BOMTag" />
</X>
```
22. Gathering PDF Files

When generating submittal documents it is often necessary to generate a set of Product Information Sheets for each part used in the job. The PDF File Reports Tool makes it easy to gather up the appropriate files, print them, or store them to disk for easy distribution.

For more information on obtaining and storing the PDF files for the parts in the Parts Database, refer to the Setup and Administration Guide.

The Gather PDF File Tool

To access the PDF File Reports tool:

- Select a Designer-specific folder in the Project View (i.e., the root Designer node or a Systems or Schedules folder); then
  - Go to the Designer Tools tab and click the GATHER PDF FILES Button; or
  - Right-click on the folder and select TOOLS → DESIGNER → GATHER PDF FILES
Gathering PDF Files

- As with Reports, you can select all the files, or you can select a subset of the Files and/or Systems in the project.
- The PDF File List shows all the PDF Files that are referenced in the selected files and systems. Each file is listed once, regardless of the number of different parts that reference it.
- You can select which version of the PDF (Submittal, Installation or Other) to use.
- There is an option to not include PDFs if the parts referenced are configured to not be included on the Bill of Materials.
- You can view a single PDF by selecting it in the list and clicking the View PDF button.

Gathering and Printing the PDF Files

Once you have selected the files to include, you can choose what you want to do with them.

- To print all the PDFs, select PRINT SELECTED PDF FILES.
- To copy all the PDFs to a folder on the computer or local network, select COPY SELECTED PDF FILES TO FOLDER and BROWSE to the folder.
- To zip up all the PDFs into a new zip file, select COMPRESS SELECTED PDF FILES TO ZIP FILE and BROWSE to specify the file name.

Click the PRINT, COPY or GENERATE ZIP button to complete the action.

The PDF Report

When you generate the PDF set, you can optionally create an Excel report that summarizes the files and the parts that referenced them. By default the GENERATE REPORT OF PDF FILES (WITH EXCEPTIONS) is turned on.

- When printing, the report will be shown in Excel (but not printed).
- When copying, the Excel report file will be copied to the destination folder.
- When zipping, the Excel report file will be included in the zip file.
<table>
<thead>
<tr>
<th>PDF File</th>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 SERIES 2010 CATALOG PDF</td>
<td>KEL-1010SP</td>
<td>Double Row 10 Terminal</td>
</tr>
<tr>
<td>100 SERIES 2010 CATALOG PDF</td>
<td>KEL-JSSPS</td>
<td>10 POLE JUMPER STRIP</td>
</tr>
<tr>
<td>910.2118 PDF: PRK 2010 CATALOG PDF</td>
<td>KEL-PRK-S</td>
<td>PRK WITH DISCONNECT SWITCH</td>
</tr>
<tr>
<td>AFS.362.pdf</td>
<td>AFS.362</td>
<td>Air Pressure Sensing Switch</td>
</tr>
<tr>
<td>100 SERIES_LOCAL_CONTROLLERS_SDS_A4.PDF</td>
<td>X9814</td>
<td>X9814, 8 U, 4 DO, 4 AO w/ker</td>
</tr>
<tr>
<td>DIN Rail ON SERIES P 2010 CATALOG PDF</td>
<td>KEL-BAM-100D</td>
<td>1 Meter, Alarm Mount Track</td>
</tr>
<tr>
<td>P-28645-9.pdf</td>
<td>M5407/43</td>
<td>DURADRY ACT ELEC 5 P-10 VDC</td>
</tr>
<tr>
<td>P-28645-9.pdf</td>
<td>M5417/73</td>
<td>DURADRY ACT ELEC 3 P-10 VDC</td>
</tr>
<tr>
<td>P-27965-8.pdf</td>
<td>V808812+4412346C0001</td>
<td>20AM ASSEMBLY M123450 O-1x1-2</td>
</tr>
<tr>
<td>P-27691-3-PDF</td>
<td>ETA55-26</td>
<td>110V Type 5 Averaging 12A Sensors</td>
</tr>
<tr>
<td>P-27691-3-PDF</td>
<td>ETA55-65</td>
<td>110V Type 5 Dust 6&quot; Sensor with</td>
</tr>
<tr>
<td>M4.6 X 6 8 2010 CATALOG PDF</td>
<td>KEL-EAM-2</td>
<td>EAM-2</td>
</tr>
<tr>
<td>M4.6 X 6 8 2010 CATALOG PDF</td>
<td>KEL-EAM-6</td>
<td>JUMPER BAR, 20 POLES/BAR</td>
</tr>
<tr>
<td>M4.6 X 6 8 2010 CATALOG PDF</td>
<td>KEL-EAM-6</td>
<td>JUMPER BAR HARDWARE</td>
</tr>
<tr>
<td>M4.6 X 6 8 2010 CATALOG PDF</td>
<td>KEL-M48</td>
<td>TERMINAL BLOCK, 10-22 AWG</td>
</tr>
<tr>
<td>M4.6 X 6 8 2010 CATALOG PDF</td>
<td>KEL-M48</td>
<td>GROUND BLOCK, 30A (GRAYEL)</td>
</tr>
<tr>
<td>M4.6 X 6 8 2010 CATALOG PDF</td>
<td>KEL-EAM-6</td>
<td>CIRCUIT SEPARATOR</td>
</tr>
<tr>
<td>M4.6XNET M4 6SF M10 10SF 2010 CATALOG PDF</td>
<td>KEL-M48XNET</td>
<td>TERMINAL GRAY ORANGE HANDLE</td>
</tr>
<tr>
<td>DISS-PETFA2-PASS06-0-16 SU M8 6N8 PDF</td>
<td>PAGA</td>
<td>3P ESP MODULE - 4 AO</td>
</tr>
<tr>
<td>DISS-PETFA2-PASS06-0-16 SU M8 6N8 PDF</td>
<td>PDB</td>
<td>3P ESP MODULE - 8 DI</td>
</tr>
</tbody>
</table>
23. Integrating with WorkPlace Tech

If your Designer drawings contain shapes representing controller devices that can be programmed with WorkPlace Tech (such as the I/A Series LON and BACnet devices), you can use the information contained in these shapes to generate template applications as a starting point for developing the application program in WorkPlace Tech.

Note:   This feature will work only with WorkPlace Tech Version 5.3 or later. WorkPlace Tech does not have to be installed on the same machine as Designer Suite 2005.

Overview of the WorkPlace Tech Integration

The purpose of this feature is to take the information about one or more devices from a Designer project and use it to build a corresponding WorkPlace Tech application file for each device.

- Designer can create a new WorkPlace Tech project that contains the applications, or the applications can be added to an existing WorkPlace Tech project.
- You can select the devices individually, viewing the list by Designer drawing file or by Designer Suite systems.
- You can have the applications created immediately (if WorkPlace Tech 5.3 is installed on the same machine as Designer) or generate an import file that can be run through WorkPlace Tech 5.3 on another machine.

An I/O control object (Analog Input, Analog Output, Binary Input or Binary Output) will be created for each I/O point defined in the Designer controller shape.

- Each I/O control object will be automatically linked to the appropriate physical point.
- The name of the I/O control object will be based on the software tag specified in the Designer controller shape.
- The point type and limits will be set according to the Designer I/O Point or Sensor shape specified in the drawing.

In addition, the application will include:

- A reference to any S-Link sensor specified in the Designer drawing.
- A control object for any Digital Expander Cards shown in the Designer drawing.
- Title Block property values carried over from the Designer Project Properties, and customizable at the time the applications are generated.
Integrating with WorkPlace Tech

This feature is designed to utilize the information specified in Designer and transfer it to WorkPlace Tech as a starting point for application development. It cannot:

- Generate any logic within the application.
- Read the application project back in to update any changes to the I/O points.
- Regenerate the application once it has been edited without overwriting any changes made by the user.

Selecting the WorkPlace Tech Project

To generate WorkPlace Tech Applications for the devices in your projects

- Select a Designer-specific folder in the Project View (i.e., the root Designer node or a Systems or Schedules folder); then
  - Go to the Designer Tools tab and click the CREATE WPT APPS Button; or
  - Right-click on the folder and select TOOLS → DESIGNER → CREATE WPT APPS

If there are any unscanned files (those added to the project but not edited from within the project), they will be scanned.

- To generate a new WorkPlace Tech project on the same machine, select the CREATE NEW PROJECT ON THIS MACHINE radio button, select the folder in which to generate the project and specify the name of the new project file.
• To add the generated applications to an existing WorkPlace Tech project on the same machine, select the **ADD APPLICATIONS TO EXISTING PROJECT ON THIS MACHINE** radio button and browse to the existing WorkPlace Tech project (.wtp) file.

• To generate a WorkPlace Tech import file (.wxp) to create a new project or add applications to an existing project on another machine, select the **GENERATE IMPORT FILE … ON ANOTHER MACHINE** radio button.

**Selecting the Devices to Convert to Applications**

An individual WorkPlace Tech application file will be generated for each selected device in the currently open Designer project.

• To generate an application for each device in the project, select the **ALL DEVICES IN THE PROJECT** radio button.

• To select the devices by viewing them within the tree of Designer drawing files, choose the **SELECT BY FILE** radio button and then click the **SELECT BY FILES…** button.

• To select the devices by viewing them within the Designer Suite 2005 Site Tree, which shows all the systems, choose the **SELECT BY SYSTEM** radio button and then click the **SELECT BY SYSTEMS…** button.
Selecting the WorkPlace Tech Document Properties

To review and update the information that will appear in the title block of the generated WorkPlace Tech applications, click on the EDIT DOCUMENT PROPERTIES… button.
Some of the fields are carried over from the Designer Project Properties, which can be edited by selecting View → Project Properties from the Project Explorer:

![Project Properties](image)

**Creating the WorkPlace Tech Applications**

After you have selected the WorkPlace Tech Project and the devices to generate, click the Generate WorkPlace Tech Project / Generate WorkPlace Tech Applications / Generate Import File button.

If you are creating the applications on the same machine, WorkPlace Tech will be launched and feed the information needed to create the project and/or applications. When it has finished, WorkPlace Tech will shut down. You will then be given the option to reopen the WorkPlace Tech project:

![WorkPlace Tech Project Created](image)
If you are generating an Import File, you will be prompted to save the .wxp file:

You will then need to transfer the generated .wxp file to another machine running WorkPlace Tech 5.3 or later, and from its Open Project dialog click on the new IMPORT… button.
You will then be prompted for the import file and asked how and where you want to create the project and applications:

Once the generation or import is complete, the WorkPlace Tech Project folder will show the applications that were generated. They will be named with the Bill of Material tag of the corresponding Designer shapes for the controller devices:
If you look at an application, you will see the I/O control objects that were created:

![Image of an application with I/O control objects]

You can now begin to create the logic for the application.

**Typical Of Systems and Smart Charts**

In Designer, you can indicate that a system is used multiple times in a project by setting the Typical Of value for the system containing the device (refer to the earlier chapter on *System Names and the System List*). If only the Typical Of value is set, Designer will still only generate a single application for the system, named for the controller’s Bill of Material tag.

If, however, you want to generate a separate application for each instance of the controller in a Typical Of scenario, you should create a Smart Chart for the device, which allows you to specify a separate Bill of Material tag for each instance. In this case the list of devices available will include each of the individual names specified in the Smart Chart. Refer to the earlier chapter on *Smart Charts* for more information.